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Introduction  

This book is intended for users who master ELMA BPM on their own and for 

specialists who plan to maintain ELMA BPM. It describes ways and methods of 

successful system administration and maintenance. The book is a reference 

guide for solving the problems that may arise when starting the system and 

during its operation. Similarly, it explains how to update the system, ensure 

reliable data storage and configure other settings. 

A short list of the main topics covered in this guide: 

• Licensing and activation of the system 

• Configuring the Web server 

• Working with databases 

• Migrating the system to another server 

• System update 

• System settings 

• System Diagnostics and Recovery 

• Submitting requests to tech support 

The guide is intended for both inexperienced users, and for professionals who 

administer and maintain various systems on a daily basis. The book describes the 

most frequently asked questions. Step-by-step instructions are provided with 

comments and images, to help system users quickly solve the problems that may 

arise.  

You can find the full description of the ELMA BPM functions in ELMA Help. ELMA Help 

is provided with the system; it is also available in the ELMA knowledge base: 

https://kb.elma-bpm.com/help 

Solutions for many technical issues are provided in the ELMA knowledge base: 

https://kb.elma-bpm.com. The knowledge base is constantly updated by the 

company’s specialists.     

If you want to report any technical issue, please visit the website of ELMA tech 

support http://support.elma-bpm.com. 

 

  

Introduction 

https://kb.elma-bpm.com/help
https://kb.elma-bpm.com/
http://support.elma-bpm./
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Chapter 1. Installing and registering ELMA 
 

Before you start working with ELMA BPM, you must install and register it. Please, 

contact our sales representatives to get the link to the software installation 

package. Read how to install and register ELMA BPM in ELMA BPM Platform user 

manual.  

If there are any difficulties when installing ELMA or when starting the system for 

the first time, contact our sales representatives or the ELMA technical support 

site (Chapter 11. Tech Support Request). 

  

https://www.elma-bpm.com/data/User_Manual_ELMA_BPM.pdf
https://www.elma-bpm.com/data/User_Manual_ELMA_BPM.pdf
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Chapter 2.  ELMA Configuration  
Configuration of ELMA includes basic system settings, object model, 

organizational structure, business processes, document flow settings and 

organization data, which is used in the ELMA Designer and in the ELMA Web 

Application.  

2.1 Location of the configuration 

By default, all configuration files are located in the UserConfig folder, which can 

be found in the ELMA directory. The path to the directory is specified when the 

system is installed and is written in the connection.config file (located in the Web 

folder of the ELMA directory). The value of the connectionString attribute 

specifies the path to the currently used configuration. 

Connection.config 

<?xml version="1.0"?> 

  <connectionStrings> 

    <add name="ConfigurationFile" connectionString="C:\ELMA3-
Standart\UserConfig\configuration.config"/> 

  </connectionStrings> 
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2.2 Configuration folder 

If you select Firebird as the DBMS, by default, the configuration folder will 

contain the database file ELMA3-EXPRESS.FDB, and the *.fbk files (backup 

copies of the database). If you select MS SQL as the DBMS, the folder will contain 

ELMA3-EXPRESS.MDF (main database) and ELMA3-EXPRESS_log.LDF 

(transaction log). The location of the database files may be different and will be 

specified in the configuration.config file in the <connectionStrings> section. 

The configuration folder stores the following files: 

 configuration.config – the main configuration file; 

 configuration.packages – a list of the system modules and their versions. 

The configuration structure includes the following directories: 

 Files – ELMA file storage, binary files of all items uploaded to the system 

(documents, photos, etc.). The path to the folder can be changed in the 

configuration file; 

 FullTextIndex – The database of full-text search providers. Lucene is the 

default provider available for all ELMA editions. It does not require a 

separate installation of the index server and a setup. ElasticSearch 

requires the installation of a separate indexing server and connection 

setup. Not available in the Express edition; 

 Notifications – system notification templates; 

 Packages – activated system modules; 

 Previews –view files which display information (data visualization) in the 

web application in the preview mode; 

 ProductionShedule – the business calendar; 

 Templates – templates of the approval sheet, acquaintance sheet and 

other templates. 

Depending on the system edition and installed modules, there may be additional 

files and folders. 

To create a backup of the ELMA configuration folder simply copy this folder. 

  

https://www.elma-bpm.ru/kb/help/elewise.elma.bpm.web.common/content/help/ru-ru/webhelp/scr/admin/elma_fulltext_server/index.html
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2.3 Configuration File 

The configuration.config file is an XML file, which by default contains the 

declaration string and one root element configuration. By default, the 

configuration file is stored in the UserConfig folder, located in the ELMA directory.   

You can find the description of the XML markup language and XML basics here. 

The configuration.config file contains information about the database 

connection, file storage connection and other system settings. The value of the 

connectionString attribute of the add element (a nested element of the 

connectionStrings) contains information about the connection to the database. 

For different DBMS, the value will be different. 

2.3.1. Firebird database connection parameters 

The following is a part of the configuration file when using the Firebird DBMS:  

Configuration.config 

<connectionStrings> 

 <add name="MainDB" connectionString="Data Source=127.0.0.1;Initial 

Catalog={CONFIGDIR}\elma3-express.fdb;User 
ID=sysdba;Password=masterkey;Port=3056;Dialect=3;ServerType=0"/> 

</connectionStrings> 

<main connectionStringName="MainDB" type="EleWise.ELMA.Extensions.Firebird.FirebirdProvider, 

EleWise.ELMA.Extensions.Firebird" backupPath=""/> 

Data source – the name and the address of the database server. If the Firebird 

server is located on the same machine as the ELMA application server, the string 

will be: 127.0.0.1, (local) or localhost. If the database server is located on a 

remote machine, then in this field you should specify the IP address or the 

network name of the machine. For example, Data source = 192.168.0.58. 

Initial Catalog – specifies the full path to the database file (*.fdb) or the database 

alias. By default, it looks like: Initial Catalog = {CONFIGDIR} \ elma3-

express.fdb. 

User ID – specifies the user name to access the database. The most commonly 

used is the default sysdba. 

Password – specifies the user’s password. The default password for the sysdba 

is masterkey. 

Port – specifies the port for the Firebird server. 

https://en.wikipedia.org/wiki/XML
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The backupPath attribute is used to set up automatic database backups. For 

more information, see Chapter 5. 

2.3.2. MS SQL database connection parameters 

The following is a part of the configuration file when using the MS SQL DBMS:  

Configuration.config 

<connectionStrings> 

  <add name="MainDB" connectionString="Data Source=(local);Initial 
Catalog=ELMA3_Express;Integrated Security=true;"/> 

</connectionStrings> 

<main connectionStringName="MainDB" type="EleWise.ELMA.Extensions.MSSQL.MSSQLProvider, 

EleWise.ELMA.Extensions.MSSQL" backupPath=""/> 

Data source – looks like ServerName\Instancename. ServerName – the name 

or the address of the DB server; Instancename – the DB server instance. If the 

instance is not specified, the default instance will be used. The default instance 

of the MS SQL server for the Express edition is SQLEXPRESS. 

Initial Catalog – specifies the database name of the selected directory of the MS 

SQL server instance, for example, ELMA3_Express.  

You can determine the location of the database files through MS SQL 

Management Studio by opening the properties of the database and clicking on 

the Files tab. 

Integrated Security – set to True if you want to use Windows authentication 

(current user on whose behalf the pool is running in IIS or Cassini). If you set 

this parameter to False, authentication will be performed at the SQL server level 

and you will be required to enter the login User ID and the password Password 

of the user who has full access to the described database. Note that if you set 

the parameter to True and simultaneously specify User ID and Password, single 

sign-on will be enabled and the user's login and password will be ignored. 

The backupPath attribute is used to set up automatic database backups. For 

more information, see Chapter 5.   
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2.3.3. PostgreSQL database connection parameters 

The following is a part of the configuration file when using the PostgreSQL DBMS:  

Configuration.config 

<connectionStrings> 

  <add name = "MainDB" connectionString = "Host=127.0.0.1;Port=5433;Database=ELMA3;User 
Id=postgres;Password=;Unicode=true;"/> 

</connectionStrings> 

<main connectionStringName="MainDB" 

type="EleWise.ELMA.Extensions.PostgreSQL.PostgreSQLProvider, 
EleWise.ELMA.Extensions.PostgreSQL" backupPath=""/> 

Host – If the PostgreSQL server is located on the same machine as the ELMA 

application server, the string will be: 127.0.0.1, (local) or localhost. If the 

database server is located on a remote machine, then in this field you should 

specify the IP address or the network name of the machine. For example, Data 

source = 192.168.0.58 

Port – specifies the port for the PostgreSQL server (the default port is 5432). 

Database – the database name. When creating a new database via the ELMA 

installer, the default name will be ELMA3. You can change this name manually. 

User ID – specifies the user name to access the database. The most commonly 

used name is the default postgres. 

Password – specifies the user’s password. When creating a new database via the 

ELMA installer, the password is set up at one of the installation steps (by default 

it is empty).  

2.3.4. Oracle database connection parameters 

The following is a part of the configuration file when using the Oracle DBMS:  

Configuration.config 

<connectionStrings> 

   <add name="MainDB" connectionString="Data Source= 
(DESCRIPTION=(ADDRESS=(PROTOCOL=tcp) 

(HOST=65.207.106.193)(PORT=1521))(CONNECT_DATA=(SID=ORATEST)));User Id=ivanovivan;    
Password=bdfyjdbx;Enlist=false;" /> 

</connectionStrings> 

 <main connectionStringName="MainDB" type="EleWise.ELMA.Extensions.Oracle.OracleProvider, 
EleWise.ELMA.Extensions.Oracle" backupPath=""  backupEnabled="false" sysUser="sys" 
sysPassword="Sd68Jkwwq" /> 
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HOST – the name and the address of the database server. 

PORT – the port for the Oracle Listener (by default it is 1521). 

SID – When creating a new database, the SID is similar to the name of the 

database (you can change it manually). 

User ID – the user’s name (Oracle object privilege). 

Password – the user’s password. 

sysUser – the user’s name (Oracle object privilege). 

sysPassword – the user’s password. 

The ELMA application server does not perform an automatic backup for the 

Oracle database. To manually create a backup, you need to perform a number 

of settings. For more information, read the Knowledge Base article Backing Up 

the Oracle Database. 

2.3.5. Configuring file storage 

The next part of the configuration file contains the file storage settings: 

Configuration.config 

<fileStore defaultProvider="FSProvider"> 

 <providers> 

  <clear/> 

  <add name="FSProvider" 
type="EleWise.ELMA.Runtime.Providers.Impl.FileSystemFileStoreProvider, EleWise.ELMA.SDK" 

filesPath="Files" previewsPath = "E:\Previews"/> 

 </providers> 

</fileStore> 

filesPath – sets the path to the storage of files uploaded to ELMA. By default, the 

value "Files" sets the following path for storing files C:\ELMA3-

Standart\UserConfig\Files. You can specify the path relatively to the UserConfig 

folder, or set a complete new path: filesPath= “D:\myfiles\files”. When using a 

network path as a file storage, you need to specify the full network path to the 

folder, for example, \\server\folder. Make sure that the user under whose name 

the ELMA server is started has permissions to access the specified path. 

previewsPath – this attribute sets the path to the storage of preview files 

generated during the system operation. If the attribute is not specified the 

system stores files in C:\ELMA3-Standart\UserConfig\Previews. 

https://kb.elma-bpm.com/article-1686.html
https://kb.elma-bpm.com/article-1686.html
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Chapter 3.  Licensing  
The ELMA BPM Platform (Fig. 1) provides basic functions that allow you to model 

and implement business processes in the organization. The ELMA product family 

includes a set of platform-based applications: ELMA ECM+ (electronic document 

management), ELMA CRM+ (customer relationship management), ELMA 

Projects+ (Project Management), ELMA KPI (KPI Management). 

To use ELMA BPM Platform, you have to purchase licenses. All the platform-

based applications are licensed separately.   

 

Fig. 1. ELMA product family 

Similarly, you have to purchase separate licenses for the additional platform 

modules, such as Integration with 1C, Barcoding and etc., and for the external 

applications, for example ELMA for IPAD, ELMA for SharePoint, etc.  

You can find up-to-date and detailed information about all the distributed system 

components at the ELMA Store: https://store.elma-bpm.com (Fig. 2). 

https://store.elma-bpm./
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Fig. 2. ELMA Store Componenets   
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3.1 License Information 

To find general information about licenses go to ELMA web application > 

Administration > License Information (Fig. 3).  

 

Fig. 3. Administartion > License Information  

To obtain the detailed information about the activated licenses go to 

Administration > System > Components (Fig. 4).  

 

Fig. 4. Administration > System > Components 

https://kb.elma-bpm.com/help/EN/Platform/content/Admin_Components_index.html?ms=AwgAAAAAAAAAAAAAAAAQICA%3D&st=MA%3D%3D&sct=MA%3D%3D&mw=MjQw
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This page also shows information about ELMA components, their statuses 

(installed/activated) and the number of activated and free licenses for each 

module. Here you can find the following details about the ELMA BPM platform: 

 System Version – the system version and edition; 

 Number of Licenses – the number of activated and occupied user 

licenses; 

 Registration Key – a thirty-digit code to generate the activation key for 

ELMA and additional modules. This unique code is generated when you 

install the system for the first time and is bound to your hardware; 

 License Expiry Date – this field is displayed only if a time-limited key 

was activated (trial version of the system); 

 Author – the author of the component; 

 Server Token – a set of numbers and symbols of English alphabet that 

encrypts the number of activated ELMA modules and applications. The 

server token is used to generate an activation key for additional 

modules and ELMA licenses. 

To see the summary about the activated modules and system licenses go to 

Administration > System > Components > in the upper menu click Copy to 

Clipboard. A pop-up window (Fig. 4) opens with the information about the 

activated modules and licenses. Click the Copy button and then insert the 

information into any text editor. 
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Fig. 5. Summry about activated components     
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3.2 Licenses types 

There are two types of licenses in ELMA: component licenses and user licenses. 

Component licenses activate a particular system module. User licenses allow 

users to access the system or a particular system module. 

3.2.1. ELMA BPM License 

This is a basic license required to start using ELMA. Additionally, you have to 

purchase user licenses. The default admin account does not require an additional 

user license. 

3.2.2. Component License 

To be able to install a component to the server, you have to purchase a 

component license. The additional user licenses are not required. Once the 

component is installed, it becomes available to all the system users. 

This is applicable to: 

 ELMA CRM+ (customer relationship management) and some other 

applications; 

 Additional modules that extend capabilities of ELMA: Integration with 

1C, Integration with Bitrix24, Integration with SharePoint, Barcoding; 

 Process packages, for example, “Document Management”, “Power of 

Attorney”.   

3.2.3. Component License + user licenses  

To be able to use a component, you must purchase a component license and a 

number of user licenses. The component will be available only for the users with 

the respective access permissions. You do not have to purchase user licenses 

for all the ELMA BPM platform users.  

To check out users who occupy licenses and have access to the component, click 

Access settings link in the description section of the respective component (read 

more in p. 2.3.5).  

This licensing scheme is applicable to the following applications: 

 ELMA Projects+ (Project Management),  

 ELMA KPI (KPIs Management). 
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3.2.4. Component License + all system licenses  

For some components you have to purchase the component license and as many 

user licenses as you have purchased for the ELMA BPM Platform. Once the 

component is activated, it will be available to all the system users. The ELMA 

ECM+ (electronic document management) is an example of such component.  

3.2.5. User Licenses  

There are two types of user licenses: named licenses and concurrent licenses. 

A Named license limits the number of unlocked users. Lock a user to make a 

license available (fig.6). 

 

Locked users will not be able to authorize in the system. Their names are not 

included in the drop-down lists in the task forms.   

 

Fig. 6. "Administration – Users". User´s Profile 

You can purchase a Concurrent Licenses for the Standard and Enterprise 

editions. This type of license limits the number of users who simultaniously work 

in the system. There are standard concurrent licenses and privileged concurrent 

liceses.  

Standard concurrent licenses are ocpupied by users who have at least one active 

session (Administration > Users > Active Usres) and who are not in the group 

of users "Privileged sign in to ELMA".  

Privileged concurrent liceses are ocpupied by users included in the group 

"Privileged sign in to ELMA". The number of users in this group cannot exceed 

the number of named licenses. 
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When calculating the number of occupied licenses, the global System 

Administrator is not taken into account. 

To view the information about the number of occupied/unoccupied, named and 

concurrent licenses, go to the Administration > System > Components (Fig. 4).  

The number of occupied/unoccupied licenses is displayed for each application, 

which requires licensing (Fig. 7).  

 

Fig. 7. User license for a component  

  



Chapter 3  Licensing  

 

 

ELMA BPM Platform: Administrator Manual                               

20 

 

3.3 System Activation  

To start using the system, you must activate it. Read the detailed description of 

how to install and register ELMA in the ELMA BPM Platform User Manual.  

Once the platform is activated, you might need to activate additional modules. 

It is required when additional modules are purchased or the number of licenses 

is extended. 

To obtain a new activation key, you need to perform the following steps.  

Open Administration > System > Components and click the Copy to Clipboard 

button in the upper menu (see 3.1 License Information). Contact your dealer 

company where you purchased the software and send them the information from 

the clipboard, the name of the additional modules, and the required number of 

licenses. They will calculate the total cost of the licenses. In addition, you can 

send a similar request to ELMA technical support. 

Once you have paid the licenses, you will be sent an additional activation key, 

generated according to the data you provided. Please, register the key.  

To do this, go to Administration > System > Components (Fig. 4) and click the 

Add Key button (Fig. 8) in the upper menu. 

 

Fig. 8. Administration > System > Components. Adding the key 

In the emerged window (Fig. 9), enter the new activation key and click the Add 

button. To activate a new module, restart the web server (read more in Chapter 

4). 

https://www.elma-bpm.com/data/User_Manual_ELMA_BPM.pdf
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Fig. 9. Administration > System > Components. Key registration window 
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3.4. Reset system activation  

Sometimes you might need to reset the system activation. For example, if by 

mistake you have activate a wrong module or additional licenses. The activation 

information is stored in the system folder, as well as in the Windows registry. 

To reset the activation of ELMA, proceed as follows: 

1. Stop the IIS service or the internal Cassini web server (see  Chapter 4 for 

details). 

2. To remove keys from the registry, use the elmaresetlicense.exe, which 

you can download from the Knowledge Base, or do it manually, by deleting 

the License folder in the Registry Editor: 

 In the branch 

HKEY_CURRENT_USER\Software\EleWise\ELMA\License; 

 In the branch 

HKEY_LOCAL_MACHINE\Software\EleWise\ELMA\License; 

 for 64 bit OS: 

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\EleWise\ELMA\Li

cense; 

 in the HKEY_USERS branch track Software\EleWise\ELMA\License in 

all user folders. 

3. Open the website folder <ELMA folder>\Web\App_Data\License and 

remove the License directory. 

4. Start the IIS service or the internal Cassini web server (for more details, 

Chapter 4). 

5. Enter the activation key, when it is required.  

 

  

https://kb.elma-bpm.com/article-1274.html
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Chapter 4.  Administering web server 
The ELMA web server is an application server for processing user requests in a 

web browser. ELMA BPM uses an IIS server or an internal ELMA server (the 

Cassini web server). IIS is the preferred option, because it provides faster and 

more stable operation, and supports not only the HTTP protocol, but also the 

HTTPS protocol. 

If when installing ELMA, IIS 7.0 or higher is already installed on your machine, 

you will be able to select between Cassini and IIS (Fig. 10). 

 

Fig. 10. Selecting a web server when isntalling the system   

You can find a systematic instruction on how to install IIS in the Knowledge 

Base. To migrate from Cassini (internal application server) to IIS, read Section 

4.3 of this manual. The installation of ELMA is described in the ELMA BPM 

Platform User Manual.  

To allow local network users to access the application server, in the Windows 

firewall, open the site port, which you specified when installing ELMA BPM. To 

learn how to configure Windows firewall, read Section 4.5 of this manual. To 

provide access from the Internet, you should set up this port on a router. 

https://kb.elma-bpm.com/article-1189.html
https://kb.elma-bpm.com/article-1189.html
https://www.elma-bpm.com/data/User_Manual_ELMA_BPM.pdf
https://www.elma-bpm.com/data/User_Manual_ELMA_BPM.pdf
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4.1 Internal ELMA Server (Cassini Web Server) 

Cassini is a free open source Microsoft web-server. You can select Cassini as a 

web server, when installing ELMA BPM. 

To start/stop the web server, use the respective Windows service: Control Panel 

> All Control panel Items > Administrative Tools > Services (Fig. 11). 

 

Fig. 11. Server Managing Service  

In the list of services, find “ELMA 3.x <Edition>”, where x is the number of the 

ELMA version. After installation, the service “ELMA 3.x <Edition>” starts under 

the system account LocalSystem. We do not recommend changing this 

parameter. Note that the account, which is used to start the service, must have 

permissions of the Windows Administrator. If you need to provide increased 

security, you should consider migrating from Cassini to IIS. 

Right-click on the service to open a context menu and select the required option 

– Start, Stop, Pause, Restart, etc. (Fig. 12). 
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Fig. 12. Services. ELMA internal web service  

The Service folder of the ELMA directory stores the web server files. The 

configuration file EleWise.ELMA.WebServer.config is used for the web server 

setup. 
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4.2 IIS web server  

IIS (Internet Information Services) – is a Microsoft proprietary web server.  

The advantages of using the IIS web server are as follows: 

• official support from Microsoft; 

• fast and stable work; 

• supports the HTTP and HTTPS protocols; 

• an application farm can be deployed; 

• single sign-on can be used; 

• a pool can be run on behalf of the built-in IIS account. 

 

This manual is not intended to provide description of initial IIS installation. For 

more information, please read this Knowledge Base article. Note that you must 

install IIS before installing ELMA BPM. 

To open the IIS manager (Fig. 13), click Windows Control Panel > Administrative 

Tools. 

If you need to restart the ELMA server, the preferable way to do it, is to restart 

the application pool (Fig. 13). Select the required pool from the list and click 

Recycle in the right menu. 

 

Fig. 13. IIS Manager. Restarting application pool 

https://www.elma-bpm.com/data/WP_ELMA_High_Load_book.pdf
https://kb.elma-bpm.com/help/EN/Platform/content/Admin_Through_autorization_index.html
https://kb.elma-bpm.com/article-1189.html
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4.2.1. .Net Framework version 

For the correct operation of the ELMA application server, make sure to specify 

the correct version of the .NET Framework in the application pool settings. You 

must use .NET Framework v 4.0. To check and change the version (Fig. 14), 

double-click on a pool or on the Basic Settings link in the right menu. 

 

Fig. 14. Configuring application pool. The .Net Framework version 

4.2.2. Application Pool Identity  

To start the application pool, select a user with permissions to read/write the 

ELMA folder. 

To configure the identity of the application pool, go to the Application Pools tab, 

in the list of application pools, select the pool used by the ELMA website. After 

selecting the necessary pool, in the right menu, click on the Advanced Settings 

... In the opened window, in the Process Model panel, check the Identity field 

(Fig. 15). The ApplicationPoolIdentity is the most secure identity. 

In some cases, you need to run the application pool once under the LocalSystem 

identity account. 
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Fig. 15. Configurinf Application Pool. The Pool Identity 

To change the identity, click the button .  
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4.3 Migrating from Cassini to IIS 

If necessary, you can migrate from the Cassini web server to IIS. To do this, 

stop the internal server and set up the service startup type at Manual or 

Disabled. For more information about configuring the server service, see section 

4.1. 

Install IIS. Then, in the IIS Manager > on the start page > in the left panel, 

select the server and in the context menu, select the Add Web Site... (Fig. 16). 

 

Fig. 16. Configuring IIS. Adding a web site 

In the emerged window, specify the web site attributes (Fig. 17); 

 Site name – specify the site name (in our case ELMA3-Enetrprise); 

 Application Pool – by default, the same as the name of the web site, 

and in most cases it does not need to be changed. 

Content Directory: 

 Physical Path – a physical path to the web site folder. Can be filled out 

manually or selected by clicking on the browse button . The ELMA 

web site is located at ../ELMA3-xx/Web, where xx is the edition of ELMA 

BPM (Community, Standard, Enterprise); 

https://kb.elma-bpm.com/article-1189.html
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 Connect as… – set up path credentials for an account of a specific 

user to access the resource via the physical path. Otherwise, use the 

default parameter Application user (pass-through authentication);  

 Test Settings… – allows you to check the availability of the Web server 

files at the specified path and with the path credentials. 

The "Binding" section contains the following fields to connect to the web site: 

Type, IP address, Port, Host name.  

As a rule, the HTTP protocol is sufficient for working in the local network. To 

change the binding type, or add another binding, in right menu > Actions > click 

Bindings.  

 IP address – the name of the server bound to the web site. The default 

value “All Unassigned” will work for most cases; 

 Port – indicates the web server which port address will receive 

requests;  

 Host name – specify the name of the web site if the connection is 

established through the host name rather than the IP address. 

Start Web site immediately –allows you to start the web site immediately. It is 

necessary to deselect this checkbox. 
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Fig. 17. Configuring IIS. Adding web site 

Once you have filled out all the fields and saved the settings, it is necessary to 

change access settings of the folder, which stores ELMA. The default path to the 

folder: C:\ELMA3-хх, where хх – is the ELMA edition (Community, Standard, 

Enterprise).  

To change access settings, right-click on the folder and select Properties. In the 

emerged window (Fig. 18), go to the Security tab and click Edit…. 
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Fig. 18. Setting access to the folder. The "Security" tab 

Then click Add and enter the following object name IIS AppPool\Elma3- хх in 

the respective field (Fig. 19), where Elma3- хх is the name of the pool. 

  

 

Fig. 19. Configuring access to the folder. The window “Select Users, Computers, Service Accounts, or 

Groups” 

Click OK to save changes and continue.  



Chapter 4  Administering web server  

 

 

ELMA BPM Platform: Administrator Manual                               

34 

 

Then in the “Permissions for ELMA3- хх” window, in the Allow row, select Modify.  

Similarly, you have to set up access to the C:\Windows\Temp folder, because 

ELMA Designer uses this folder to compile the script code. 

The next step is to check the .Net Framework version and the identity of the 

application pool (see sections 4.2.1 and 4.2.2 of this manual). 

Once these steps are complete, open the IIS Manager and start ELMA web site. 

To do this in the left menu, select the required site and in the right menu click 

the Start button (Fig. 20). 

 

Fig. 20. Starting IIS web server 

Once it is done, restart the application pool, by selecting the required pool in the 

list of Allocation pools and clicking the Recycle button. The system is ready for 

operation.  
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4.4 Changing ELMA web server port 

The connection port is specified when the system is installed. By default, ELMA 

uses the 8000 port. If necessary, you can change this port. 

Before changing the port, make sure that the port is open in the firewall and is 

specified in the router. Otherwise, the server will be unavailable from other 

computers. 

4.4.1. Changing IIS port  

To change the port of ELMA BPM which is run on the IIS web server, go to Start 

> Control Panel > Administrative Tools > IIS Manager. In the emerged window 

> in the left menu > in the Sites section select the required site (Fig. 21).  

 

Fig. 21. IIS Manager. Selecting web site 

Right-click on the web site name and in the context menu select Edit Bindings … 

(Fig. 22). 
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Fig. 22. IIS Manager. Context menu item 

In the window that opens, select the binding and click Edit. Then enter the data 

(Fig. 23): specify the new port and click OK. Note that the specified port must 

be free.  

  

 

Fig. 23."Editting web site binding" window 

Type – select the required protocol (http or https) from the drop-down list to 

bind a site. In our case, the http protocol is used. 

IP Address – The IP address used to access this site. By default, select All 

Unassigned. 

Port – server port used to listen to requests addressed to this site. The port 

specified in this field must be free. In our case, port 8000 is used for the test 
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environment. By default, an exception may not be configured for this port, so to 

access from the outside of the local network, create a new exception in Windows 

Firewall. 

Host name – the name of the host. In our case, this field is empty. 

After that, restart the application pool. 

4.4.2. Changing port when using Cassini 

To change the port of ELMA, which runs on the internal Cassini server, go to 

Start > Control Panel > Administrative Tools > Services. In the list find the 

"ELMA Web Server 3.x <Edition>" service and in the context menu select 

Stop. 

Then, in the ELMA directory, go to the Service folder and open the 

EleWise.ELMA.WebServer.config file. In the line "<Port> 7000 </ Port>", 

change the value "7000" to a new one. The specified port must be 

unoccupied. 

After that, save changes and start the "ELMA Web Server 3.x<Edition>" 

service. 

4.5 Configuring Windows firewall 

Configure Windows Firewall to enable computers of the local network to connect 

to the application server and, if necessary, to the ELMA Designer. 

First, you need to specify which port to open. If you use the internal Cassini web 

server, you should open the file …\<Shared folder with system 

files>\Service\EleWise.ELMA.WebServer.config (Fig. 24)/ 
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Fig. 24. Specifying the port of the Cassini server 

If you use IIS, please read the section 4.4.1 of this manual to find out 

information about the port. 

To check or change the port of ELMA Designer, in the ELMA web application > 

go to Administration > System > System settings. In the General Settings block, 

you will see the Designer connection port (Fig. 25). To change the port, click the 

 icon in the upper right corner of the block. 

 

Fig. 25. "Administration – System – System Settings". The "General Settings" block. 
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Once you have found out the port numbers that must be unoccupied, go to Start 

> Control Panel > All Control Panel Items > Windows Firewall, in the open 

window in the left menu, select Advanced Settings (Fig. 26).  

 

Fig. 26. Control panel. Windows Firewall. 

In the emerged window (Fig. 27), in the left menu select Inbound Rules, then in 

the right menu click New Rule….  

 

Fig. 27. Control Panel. Windows Firewall. The "New Rule…" link 
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Further actions are shown in the figures below (Fig. 28 – Fig. 32). To switch 

between the wizards’ steps, use the Next and Back buttons. 

 

Fig. 28 New Inbound Rule Wizard. Step 1 



Chapter 4  Administering web server  

 

 

ELMA BPM Platform: Administrator Manual                               

41 

 

 

Fig. 29 New Inbound Rule Wizard. Step 2 

 

Fig. 30 New Inbound Rule Wizard. Step 3 
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Fig. 31 New Inbound Rule Wizard. Step 4 

 

Fig. 32 New Inbound Rule Wizard. Step 5 
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To create a rule, click Finish. Similarly, you can create a rule for the ELMA 

Designer port (the default port is 7100). 
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Chapter 5. Working with databases 
A database is one of the main ELMA components. ELMA Express uses the Firebird 

DBMS (version 2.5 and version 3.0 for ELMA 3.9.0 and higher) and PostgreSQL 

(version 9.5 and higher). For ELMA Standard, the following DBMS are available 

Firebird, PostgreSQL and Microsoft SQL Server (version 2008, 2012 and 2014 in 

compatibility mode with 2012). ELMA Enterprise uses Firebird, PostgreSQL, 

Microsoft SQL Server or Oracle Database (10, 11, and 12). 

You can select the DBMS when installing ELMA. To create the ELMA database 

backup you must use the DBMS tools. The employees who maintain the IT 

infrastructure of the company are responsible for creating backups of the DBMS, 

configuration directory and file storage, selecting the schedule, checking 

performance of the backup tools. 

5.1 Backing up the ELMA database 

Regular database backups with mandatory integrity check guarantees stable and 

trouble-free operation.  

You can determine the type, name and access attributes of the database by 

opening the configuration file configuration.config (for more details, see section 

2.3). By default, this file is stored at the path C:\ELMA3-xx\UserConfig, where 

xx is the system edition (Express, Standard, Enterprise), and UserConfig is the 

name of the ELMA configuration folder. 

In the configuration file configuration.config, you need to find a line starting with 

the <main> tag (Fig. 33). In the type field, the FirebirdProvider, 

PostgreSQLProvider, MSSQLProvider, or OracleProvider class is specified. The 

class name corresponds to the type of the database used. 

To determine the name of the database, in the same file, find the 

<connectionStrings> tag. The Data Source parameter contains information 

about the path to the server (its address). The value of the Initial Catalog 

attribute shows the name of the database file. 
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Fig. 33. Determining the database type and the conncetion sting  

You can find examples of the configuration files in the following sections: 

 Firebird database connection parameters 

 ; 

 MS SQL database connection parameters; 

 Oracle database connection parameters; 

 PostgreSQL database connection parameters. 

Please note that a copy of the database is created when the backup procedure 

is started. To ensure that all data is backed up, you must close all active 

database connections before starting the backup. To do this, you need to stop 

the ELMA application server, this procedure is described in Chapter 4.  

For the Firebird, PostgreSQL and MS SQL DBMS, ELMA automatically creates a 

database backup when the database structure is changed (initiated after the 

system update). To set up this feature, use the configuration file. Below you can 

see a part of the XML file: 

Configuration.config with enabled backup 

<main connectionStringName="MainDB" type="EleWise.ELMA.Extensions.MSSQL.MSSQLProvider, 
EleWise.ELMA.Extensions.MSSQL" backupPath=""/> 

 

Configuration.config with disabled backup 

<main connectionStringName="MainDB" type="EleWise.ELMA.Extensions.MSSQL.MSSQLProvider, 
EleWise.ELMA.Extensions.MSSQL" backupEnabled="False"/> 
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The backupEnabled attribute is responsible for the backup. It can have different 

values: 

 If the value is False, the backup will not be created. When the backup 

is disabled, the backupPath attribute (the path of the backup files) can 

be omitted; 

 If the attribute is changed to backupPath (the attribute backupEnabled 

is omitted, the default value is True), the backup is created. The 

backupPath parameter specifies the path to the backup files. If this 

field is left blank, then the backup will be created in the same place 

where the main database is located. The file name is generated 

automatically and contains the name of the database file, the date and 

time when the backup was created. 

5.1.1. Firebird DBMS 

If many users work in ELMA Express on the Firebird server, with time they can 

experience decrease in the system performance. In the ELMA Knowledge Base, 

you can find one of the possible solutions for this problem.  

You can create a backup for the Firebird DBMS in various ways. For example, 

you can use the gbak utility and the bat file to automatically create regular 

database backups. Read more in this article.  

If you want to manually create a copy of the database, use the IBExpert utility 

for administering the InterBase and Firebird databases. In this Knowledge Base 

article, you can learn how to install the program, set up the connection to the 

database, and find the description of the basic features.  

Once you have installed the IBExpert and created the connection to the DB, in 

the left menu select the ELMA database (Fig. 34), and then go to the menu 

Service – Backup Database (Fig. 35). 

https://kb.elma-bpm.com/article-1734.html
https://kb.elma-bpm.com/article-1734.html
https://kb.elma-bpm.com/article-1735.html
https://kb.elma-bpm.com/article-1735.html
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Fig. 34. IBExpert. Selecting the database 

 

Fig. 35. IBExpert. Creating a backup 

The Database Backup (Рис. 36) window will open. In the Backup Files tab, some 

of the required values will be already specified. The Firebird database backup 

file will have a .fbk extension and by default will be located in the same folder 

as the database. The location of the database will be specified in the File Name 

field. At the bottom of the window, in the Output section, select On Screen from 

the drop-down list to display the copy of the protocol.  



Chapter 5  Working with databases  

 

 

ELMA BPM Platform: Administrator Manual                               

48 

 

 

Рис. 36. IBExpert. Creating a backup. Settings 

To start the database backup, click Start Backup. The Output tab will open 

displaying all the copying messages. 

5.1.2. MS SQL DBMS 

There are several ways to create a backup of the MS SQL database. Further, we 

will describe how to create a backup in the MS SQL Management Studio. 

Start MS SQL Management Studio, in the Connect to Server dialog box (Fig. 37), 

fill in the following attributes: 

 Server Type – the Database Engine component is used; 

 Server Name – The server instance for the connection is specified in the 

Data Source attribute of the configuration file; 

 Authentication – There are two authentication modes for the Database 

Engine: 

o Windows Authentication – allows a user to connect through a 

Windows user account (single sign-on); 
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o SQL Server Authentication - the SQL account is used. In the Login 

field, you must specify a name in the following format: 

ELEWISE\test_user, where ELEWISE is the domain name, test_user 

is the user account. In the Password field, specify the password for 

this account. 

 

Fig. 37. MS SQL.Database Connection  

Click Connect.  

After successfully connecting to the database server, select the database 

specified in the Initial Catalog attribute of the configuration file (Fig. 38). Read 

how to verify the required database in the section 5.1.  

 

Fig. 38. MS SQL. Selecting database 
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Right click on the sql database which you want to back up. In the context menu, 

select Tasks –Back up… (Fig. 39).  

 

Fig. 39. MS SQL. Backin up 

The Back up Database window opens (Fig. 40), where you have to specify the 

required data.  

In the General tab, you can select the source type. If you select the Copy-only 

Backup parameter, you will take a SQL Server backup that is independent of the 

sequence of conventional SQL Server backups. Usually, taking a backup changes 

the database and affects how later backups are restored. However, occasionally, 

it is useful to take a backup for a special purpose without affecting the overall 

backup and restore procedures for the database. Copy-only backups serve this 

purpose. 
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Fig. 40. MS SQL. Backing up DB. The "General" Tab 

In the Destination section of the General tab, select the file or backup device for 

the backup destination. By default the database backup will be located in the 

C:\Program Files\Microsoft SQL 

Server\MSSQL12.MSSQLSERVER\MSSQL\Backup\ (the name of the file will 

match the name of the database with the .bak extension). Please note that one 

file can store several backups of different databases. If you click on the Content 

button, you will see a list of backups of all databases (Fig. 41), stored in the file 

with detailed information about them. 



Chapter 5  Working with databases  

 

 

ELMA BPM Platform: Administrator Manual                               

52 

 

 

Fig. 41. MS SQL. The file with the database backups  

If you want to change the backup path or file, first click the Remove button, then 

click Add and in the window that opens (Fig. 42) specify the full path and file 

name, or click the  button and select a new path to the file and the file name. 

You should also add a .bak extension at the end of the file name. 

 

Fig. 42. MS SQL.Selecting the file or backup device for the backup destintaion  

In the Options tab you can select Set backup compressions to shrink the amount 

of storage space used by your backup files. 

Once you have configured all the options, a dialog box opens, informing you 

about the successful backup.  
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5.1.3. PostgreSQL DBMS 

There are several ways to back up a PostgreSQL database. Below we will 

describe the backup option in the pgAdmin III application (this utility for 

database administration is installed by default together with the DBMS). 

 

Start pgAdmin III, in the Object browser find the required DB server (Fig. 43).  

 

Fig. 43. pgAdmin III application 

If the server does not exist, establish a new connection File > Add Server... 

menu (the first icon in the toolbar). 

Enter the details to connect to the database in the New Server Registration 

window. (Fig. 44): 

 Name – enter a name for this connection to distinguish it from the others 

(you can select any name); 

 Host – enter a name of the server where your hosting account is located; 

 Port – The port number specified when installing the database (by default 

5432); 
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 Service – The name of the service configured in the file pg_service.conf 

(by default leave this field empty); 

 Maintenance DB –  this is a system database to which all users and 

applications are connected by default. In PostgreSQL 8.1, it is Postgres, 

and on earlier versions, it is template1. 

 

Fig. 44 PostgreSQL. Registering a new server 

After successfully connecting to the database server, select the database 

specified in the Database attribute of the configuration file. Read how to verify 

the required database in the section 5.1. 

Next, in the context menu, select the Backup option ... (Fig. 45). 
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Fig. 45. pgAdmin III application. The DB context menu. 

The Backup database “DB name” window opens (Fig. 46).  

 

Fig. 46. pgAdmin III appliaction. Backup parametrs  

Specify the following parameters: 
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 Filename – Enter the name of the backup file in the Filename field. 

Optionally, select the Browser icon (...) to the right to navigate into a 

directory and select a file that will contain the archive; 

 Format – select the format of the backup. The following options are 

available: 

o Custom – This format allows you to select which database objects 

to restore from the backup file. Custom archive format is 

recommended for medium to large databases as it is compressed 

by default; 

o Tar – Select Tar to generate a tar archive file that you can restore 

with pg_restore. The tar format does not support compression. 

If you use the tar format, when you restore, you will not be able 

to change the relative order of data items; 

o Plain – the Plain format is normally recommended for smaller 

databases. The pgAdmin utility does not support the recovery of 

backups from this format; 

o Directory – This file format creates a directory with one file for 

each table and blob being dumped, plus a Table of Contents file 

describing the dumped objects in a machine-readable format 

that pg_restore can read. This format is compressed by default; 

 Compress Ratio – Use the Compress Ratio field to select a compression 

level for the backup. Specify a value of zero to mean use no 

compression; specify a maximum compression value of 9. Please note 

that Custom format is compressed better than Directory and Plain. Tar 

archives do not support compression; 

 Encoding – Use the Encoding drop-down listbox to select the character 

encoding method that should be used for the archive. By default, it is 

UTF8; 

 Rolename – Use the dropdown listbox next to Rolename to specify the 

role that owns the backup. By default, it is postgres. 

All additional parameters are left by default. Click on the Backup button. The 

Messages tab displays a list of all operations performed with the exit code. If the 

backup is successful, the Messages tab will display: “Process returned exit code 

0”. In the Messages tab, you can also check how to run this operation from the 

command line. 
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5.1.4. Oracle DBMS 

The detailed description of how to back up the Oracle DB see in the Knowledge 

base. Please remember that when updating ELMA, a copy of the Oracle database 

is not created automatically, unlike the Firebird and MS SQL databases. 

  

https://kb.elma-bpm.com/article-1686.html
https://kb.elma-bpm.com/article-1686.html
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5.2 Restoring databases 

Restoring a database is one of the DBMS functions. The restored database will 

be in the state it had at the time when the backup was created. The Firebird 

backup files have the .fbk extension. The MSSQL backup files have the .bak 

extension, and the PostgreSQL files - .backup. To restore the database, first stop 

the web server on which ELMA is running. For more information, see Chapter 1. 

5.2.1. Firebird DBMS 

Consider the procedure for restoring a database in IBExpert. Select Services - 

Restore Database (Fig. 47).  

 

Fig. 47. IBExpert. Restoring database 

You can restore the backup to an existing database, or to a new one. To restore 

the backup to a new database, in the Files tab (Fig. 48), select the New database 

option in the Restore into drop-down list (Figure 48). To restore to the existing 

database, select Existing Database. In the Database File field, enter the full path 

to the new (or existing) database file. In the File Name field, enter the path to 

the backup file or use the Browse button to select the file. 
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Fig. 48. IBExpert. Restorung database 

You can also change the size of the database page by selecting it from the Page 

Size drop-down list. The database performance depends on the size of the page. 

The database file is divided into pages of a fixed size; the server reads 

information from the disk and writes it to the disk page by page. To increase 

performance, it is recommended to set the page size to 16384 bytes. 

Recommendations for choosing the page size: 

 for the disk drives with NTFS file system - 4096 bytes. Make sure that the 

NTFS disk cluster size is set to 4096 bytes; 

 for the disk drives with FAT32 – 8192 or 16384 bytes. 

Click the Start Restore button. In the window that open, enter the user name 

and password. You can restore the database as a SYSDBA user (the default 

password is masterkey). The database will be restored from the backup.  
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5.2.2. MS SQL DBMS 

In this section, we will describe how to restore the database in the MS SQL 

Management Studio.  

In the Object Explorer, select the database you want to restore and in the 

context menu select Task > Restore > Database (Fig. 49). 

 

Fig. 49 MS SQL. The database context menu. 

In the emerged window (Fig. 50) select the database restoring options.  
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Fig. 50 MS SQL. Selecting Database Restoring Options 

In the General tab, specify the Destination for Restore: 

 Database – Select the database to restore. You can enter a new database 

or select an existing one from the drop-down list; 

 Restore to (a point in time) – Restore the most recent backup of the 

database or a backup created at a certain point in time. Default Value: 

Most recent possible. 

The Source for Restore settings determine the location of the backup sets for 

the database and the specific backup set that you want to restore: 

 From database – Select the database from the list. This list contains only 

databases that have been backed up in accordance with the msdb backup 

log; 

 From device – Select logical or physical backup devices (tapes or files) that 

contain the required backup or backups for recovery.  

 In the Options tab select the restore options: 

 Overwrire the existing database – allows you to overwrite the files of the 

database that is currently using the database name specified by you. 



Chapter 5  Working with databases  

 

 

ELMA BPM Platform: Administrator Manual                               

62 

 

Attention! This option is recommended only after a thorough analysis of 

the possible consequences! 

 Preserve the replication settings – Select to restore backups of replicated 

databases. A published database can be restored to a server other than 

the server where the database was created. This is relevant only to full 

backups and if the database was part of a replication implementation.  

 Prompt before restoring each backup – Select this option if you wish to be 

prompted between each restore operation. This is not usually necessary 

unless the database is large and you wish to monitor the status of the 

restore operation. The option is especially useful when you need to change 

tapes in the device, for example, if there is only one tape device on the 

server. 

 Restrict access to the restored database – Select this option to make the 

restored database accessible only to the following roles db_owner, 

dbcreator or sysadmin.  

To specify the database recovery state after the restore operation, you must 

select one of the options in the Recovery state section. For more information, 

see the MS SQL Management Studio Help. 

Once you have seleceted all the necessary options, click OK. After that, the 

recovery operation starts. The progress of the operation is displayed as a 

percentage in the left part of the dialog box. When the operation is complete, 

the dialog box displays the execution status. 

5.2.3. PostgreSQL DBMS 

Below we will describe how to restore a database in pgAdmin III. Select an 

existing database or create a new one, right-click on it and select Restore… from 

the context menu (Fig. 51).  

https://docs.microsoft.com/en-us/sql/ssms/use-sql-server-management-studio
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Fig. 51. PostgreSQL. Restoring a database 

In the window that opens (Fig. 52), in the File Options tab fill in the following 

fields: 

 Format – Select the backup format; 

 Filename – When selecting the Custom or Tar format, specify the 

path to the backup file, in case of using the Directory format, specify 

the path to the corresponding backup folder;  

 Number of jobs – Use this filed to instruct the server to use multiple 

concurrent jobs for the restore. This option allows you to reduce the 

recovery time of a large database when the server is running on a 

multiprocessor computer. The optimal value for this option depends 

on the hardware setup of the server, of the client, and of the 

network. As the initial value, you can specify the number of cores on 

the server, but by increasing this value, you can make the recovery 

faster. If the value is too high, performance will decrease due to 

overload. This option is supported only by the Custom and Directory 

archive formats. You can leave this field empty, in this case the 

restore operation will be carried out in the normal mode; 
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 Role name – Use the Rolename field to specify the name of the role 

that will be used when invoking pg_restore. By default, postgres. 

 

Fig. 52. PostgreSQL. Restoring a DB 

Do not change other options on the remaining tabs, to perform the complete 

database restore. Generally, additional options are set up if partial recovery of 

the database is required (for example, without certain tables, data).  

Click on the Restore button. The Messages tab displays a list of all operations 

performed with the exit code. If restore is successful, the Messages tab will 

display: Process returned exit code 0. In the Messages tab, you can also check 

how to run this operation from the command line. 

5.2.4. Oracle DBMS 

A detailed description of how to restore an Oracle database is given in the 

Knowledge Base article.   

https://kb.elma-bpm.com/article-1736.html
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Chapter 6.  Configuring ELMA test server  
When working in ELMA, you often need to make some improvements: streamline 

business processes, improve object model, interfaces, etc. Thus, it’s important 

to provide possibility to implement changes and at the same time ensure 

continuous operation of the system. The best solution is to create an ELMA test 

server, where you will be able to improve and test new features. Then tested 

features can be transferred to the ELMA production server (see Section 6.2).  

6.1 Setting up test environment  

Below you will find the recommended steps to set up a test server. 

1. Install the same version of ELMA as on the production server. The version of 

the system is displayed in the right bottom corner of any page of the web 

application, as well as in the header of the ELMA Designer window (for details 

on the version numbering see Section 0). To find out the full version of the 

ELMA installation file, right-click the installation file and select Properties. In 

the opened window (Fig. 53), you must go to the Details tab. 

  

 

Fig. 53. Determining the version of the ELMA installation file 
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Read a step-by-set description of how to install and register ELMA in the 

ELMA BPM Platform User Manual. Please note that an activation key is always 

required to start using ELMA on a new server. However, we can provide a 

trial license with the limited number of users and period of use for 

implementing improvements and debugging. For more details, see section 

3.2.5.  

2. Stop the ELMA test server (read more in Chapter 4). 

3. Create a database backup on the production server and restore it on the test 

server (read more in Section 5.1). 

4. Copy configuration folder UserConfig on the production server and replace it 

on the test server. 

5. Copy the folder with the binary system data from the production server and 

transfer it to the test server. By default, it is the Files folder in the UserConfig 

folder. 

6. If necessary, reset user passwords and remove e-mails - to get full access to 

the system and prevent user’s alerts through e-mail. 

You can perform these steps by connecting to the restored database in MS SQL 

Management Studio, pgAdmin or IBExpert (depending on the database used) 

and executing the SQL query below: 

 

https://www.elma-bpm.com/data/User_Manual_ELMA_BPM.pdf
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MS SQL DBMS, if you do not use LDAP integration 

UPDATE "UserSecurityProfile" 
SET  
   "UserSecurityProfile"."Password" = 'd41d8cd98f00b204e9800998ecf8427e', 
   "UserSecurityProfile"."Salt" = NULL, 
   "UserSecurityProfile"."ForcedChangePassword" = NULL, 
   "UserSecurityProfile"."CountFailedLogon" = NULL; 
UPDATE "User" 
SET "User"."EMail" = ' ' 

Firebird DBMS, if you do not use LDAP integration 

UPDATE USERSECURITYPROFILE 
SET  
   "Password" = ' ', 
   FORCEDCHANGEPASSWORD = NULL, 
   COUNTFAILEDLOGON = NULL,  
   SALT = NULL 

UPDATE "User" 
SET EMAIL = ' ' 

PostgreSQL DBMS, if you do not use LDAP integration 

UPDATE "usersecurityprofile"  
SET  
   "Password" = 'd41d8cd98f00b204e9800998ecf8427e', 
   salt = NULL, 
   forcedchangepassword = NULL, 
   countfailedlogon = NULL; 
UPDATE "User" 
SET Email = ' ' 

MS SQL DBMS, if you use LDAP integration 

UPDATE "UserSecurityProfile" 
SET  
    "UserSecurityProfile"."Password" = 'd41d8cd98f00b204e9800998ecf8427e',  
    "UserSecurityProfile"."Salt" = NULL, 
    "UserSecurityProfile"."ForcedChangePassword" = NULL, 
    "UserSecurityProfile"."CountFailedLogon" = NULL; 
UPDATE "User" 
SET  
    "User"."EMail" = ' ', 
    "User"."AuthProviderGuid" = '00000000-0000-0000-0000-000000000000' 

Firebird DBMS, if you use LDAP integration 

UPDATE USERSECURITYPROFILE 
SET  
   "Password" = ' ', 
   FORCEDCHANGEPASSWORD = NULL, 
   COUNTFAILEDLOGON = NULL, 
   SALT = NULL 

UPDATE "User" 
SET 
   EMAIL = ' ', 
   AUTHPROVIDERGUID = ' ' 

PostgreSQL DBMS, if you use LDAP integration 

UPDATE "usersecurityprofile"  
SET  
   "Password" = 'd41d8cd98f00b204e9800998ecf8427e', 
   salt = NULL, 
   forcedchangepassword = NULL, 
   countfailedlogon = NULL; 
UPDATE "User" 
SET  
   Email = ' ' 
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Fig. 54. Example of query execution in MS SQL 

 

Fig. 55. Example of query execution in IBExpert 

   authproviderguid = '00000000-0000-0000-0000-000000000000' 
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7. Disable e-mail/SMS notifications, so that users do not receive alerts about 

events that occur on the test server. To do this use the respective database 

query. 

MS SQL DBMS 

UPDATE [SYSTEMSETTINGS] 
SET [SETTINGVALUE] = 'False' 
WHERE [SETTINGKEY] = 'Enabled' 
AND [MODULEUID] IN ('D13E29C4-3419-41FA-B86B-3BF88E7A3B71',  
'1B5CEBDA-1A63-42E2-8B6A-6E875C05B136') 

Firebird DBMS 

UPDATE systemsettings 
SET systemsettings.settingvalue = 'False' 
WHERE systemsettings.settingkey = 'Enabled' 
AND systemsettings.moduleuid IN (char_to_uuid('C4293ED1-1934-FA41-B86B-3BF88E7A3B71'),  
char_to_uuid('DAEB5C1B-631A-E242-8B6A-6E875C05B136')) 

PostgreSQL DBMS 

UPDATE SYSTEMSETTINGS 
SET SETTINGVALUE = 'False' 
WHERE SETTINGKEY = 'Enabled' 
AND MODULEUID IN ('D13E29C4-3419-41FA-B86B-3BF88E7A3B71',  
'1B5CEBDA-1A63-42E2-8B6A-6E875C05B136') 

8. If there are processes that start on a schedule (for example, integration with 

external systems), then it is recommended to unpublish such processes in 

order to prevent conflicts with the production server.  

See below how to unpublish the “Leave request” process. Similarly, you can 

cancel publication of any other process. 

MS SQL DBMS 

UPDATE [PROCESSHEADER] 
SET [PUBLISHED] = Null 
WHERE [NAME] = 'Leave request' 

Firebird DBMS 

UPDATE processheader 
SET processheader.published = Null 
WHERE processheader.name = 'Leave request' 

PostgreSQL DBMS 

UPDATE PROCESSHEADER 
SET PUBLISHED = Null 
WHERE "Name" = 'Leave request' 

9. If you want to clean a database from started processes and incomplete tasks 

transferred from the production server, you can interrupt them with a query. 

An example is given below. 

Attention! Perform this operation only if you are sure of what you are doing.  
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MS SQL DBMS, interrupting active tasks in the “Leave Request” process 

UPDATE [TASKBASE] 
set [STATUS] = 'fd7993c6-99c7-4b23-83cc-0f576a63c144', 
[ENDWORKDATE] = CURRENT_TIMESTAMP 
WHERE [WORKFLOWBOOKMARK] IN 
  (SELECT [ID] FROM WORKFLOWBOOKMARK WHERE INSTANCE IN 
    (SELECT [ID] FROM [WORKFLOWINSTANCE] WHERE [STATUS] = 1 AND [PROCESS] IN 
      (SELECT [ID] from [WORKFLOWPROCESS] WHERE [HEADER] IN 
        (SELECT [ID] from [PROCESSHEADER] WHERE [NAME] = 'Leave request')))) 
AND ENDWORKDATE is null 

MS SQL DBMS, interrupting active instances of the “Leave Request” process 

UPDATE [WORKFLOWINSTANCE] 
SET [STATUS] = 4 
where [PROCESS] IN 
  (SELECT [ID] FROM [WORKFLOWPROCESS] WHERE [HEADER] IN 
      (SELECT [ID] FROM [PROCESSHEADER] WHERE NAME = 'Leave request')) 
AND [STATUS] = 1 

PostgreSQL DBMS, interrupting active tasks in the “Leave Request” process  

UPDATE TASKBASE 
set STATUS = 'fd7993c6-99c7-4b23-83cc-0f576a63c144', 
ENDWORKDATE = CURRENT_TIMESTAMP 
WHERE WORKFLOWBOOKMARK IN 
  (SELECT ID FROM WORKFLOWBOOKMARK WHERE INSTANCE IN 
    (SELECT ID FROM WORKFLOWINSTANCE WHERE STATUS = 1 AND PROCESS IN 
      (SELECT ID from WORKFLOWPROCESS WHERE "Header" IN 
        (SELECT ID from PROCESSHEADER WHERE "Name" = 'Leave request')))) 
AND ENDWORKDATE is null 

PostgreSQL DBMS, interrupting active instances of the “Leave Request” process 

UPDATE WORKFLOWINSTANCE 
SET STATUS = 4 
where PROCESS IN 
  (SELECT ID FROM WORKFLOWPROCESS WHERE "Header" IN 
      (SELECT ID FROM PROCESSHEADER WHERE "Name" = 'Leave request')) 
AND STATUS = 1 

Firebird, DBMS, interrupting active tasks in the “Leave Request” process 

update taskbase tb 
set tb.status = char_to_uuid('C69379FD-C799-234B-83CC-0F576A63C144'), 
tb.endworkdate = current_timestamp 
where tb.workflowbookmark in 
  (select id from workflowbookmark wfb where wfb.instance in 
    (select id from workflowinstance wfi where wfi.status = 1 and wfi.process in 
      (select id from workflowprocess wfp where wfp.header in 
        (select id from processheader ph where ph.name = 'Заявка на отгул')))) 
and tb.endworkdate is null 

Firebird DBMS, interrupting active instances of the “Leave Request” process 

update workflowinstance wfi 
set wfi.status = 4 
where wfi.process in 
  (select id from workflowprocess wfp where wfp.header in 
      (select id from processheader ph where ph.name = 'Заявка на отгул')) 
and wfi.status = 1 
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10. Start test server. 

6.2 Exporting and Importing Configuration  

The ELMA Designer application is installed on the user's computer and provides 

a convenient interface for modeling processes, describing the company's 

organizational structure, and creating configurations. You can read more about 

the ELMA Designer features in ELMA BPM Platform User Manual. Here are some 

specific features of ELMA Designer: 

1. To work in ELMA Designer, a user must have special permissions. For 

more information, see ELMA Help. 

2. When editing context of objects, document types and processes, it is 

not recommended to change and delete property names after initial 

publication. If for some reason one of the context variables is no longer 

needed, it is recommended to hide this variable in the forms, and also 

to change the display name, adding "(not used)" at the end of the 

name.  

3. If several users work in ELMA Designer simultaneously, then it is 

necessary to adhere to the following rules: 

• Every user must work under his/her account; 

  Several users should avoid editing the same ELMA object 

simultaneously. 

4. When transferring data from the test server to the production server 

in the export file, it is recommended to include only the modified 

objects. 

The import and export procedure is generally used: 

• for transferring configurations from server to server, incl. from test and 

production servers in both directions; 

• to install process packages from the ELMA Store. 

Below you will find the complete list of system objects you can transfer from one 

ELMA server to another. Note that depending on the activated ELMA applications, 

the list can contain fewer objects: 

 organizational structure; 

 user groups; 

 system objects that can store data; 

https://www.elma-bpm.com/data/User_Manual_ELMA_BPM.pdf
https://kb.elma-bpm.com/help/EN/Platform/content/Admin_process_modelling_access_index.html?ms=AwAAAAAAAAAAAAAAAAAQQA%3D%3D&st=MA%3D%3D&sct=MA%3D%3D&mw=MjQw
https://store.elma-bpm.com/
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 system enumeration; 

 document types and record cards; 

 project types; 

 business processes; 

 custom extensions; 

 reports; 

 pages and portlets; 

 Razor's views; 

 KPIs, goal maps, goals, data sources, scheduler tasks; 

 message queues; 

 global modules. 

To get more information, please refer to ELMA help or the Knowledge Base 

article. 

  

https://kb.elma-bpm.com/help/EN/Platform/content/Designer_Architecture_ELMA_index.html
https://kb.elma-bpm.com/article-1738.html
https://kb.elma-bpm.com/article-1738.html
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6.3 Example: How to transfer a part of configuration 

Suppose a company’s business analyst has had to make changes in the 

“Purchase request” business process (Fig. 56) to bring the business process into 

compliance with the new regulations. Let’s assume that both test and production 

servers are already set up. 

 

Fig. 56. ELMA Designer. The "Procurement request" business process. Version 1 

You need to perform these steps: 

1. Start ELMA Designer on the test server, enter the login and password 

of a user with access permissions to ELMA Designer. By default, once 

the system is installed, it is admin with a blank password. 

  

2. In accordance with the new regulations, a user must complete the task 

“Pay the invoice” in 5 days. If a user does not keep the deadline, the 

process Initiator must be notified. Change the business process to 

meet new regulations and publish it (Fig. 57). Read more how to 
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publish a process in section 5.1.11 of the ELMA BPM Platform User 

Manual. 

 

 

 

Fig. 57. ELMA Designer. The " Procurement request" business process. Version 2 

3. The next important step is to test business processes. Start the process 

on the test server various times with different input data and make 

sure that the process logic is correct. You may also use the debugging 

feature to detect errors and fix bugs. Read more about the debugging 

in the section 5.1.10 of the ELMA BPM Platform User Manual. 

 

4. Once all the tests are performed, transfer the streamlined business 

process to the production server. To do this, in the ELMA Designer, 

open the Menu tab > Configurations > Export Configuration, specify 

the folder and the name of the export file that will store the exported 

information (Fig. 58). 

Since in this example you only modify one business process, it is not 

required to export other objects. Click Next to proceed to the Processes 

step.  

https://www.elma-bpm.com/data/User_Manual_ELMA_BPM.pdf
https://www.elma-bpm.com/data/User_Manual_ELMA_BPM.pdf
https://www.elma-bpm.com/data/User_Manual_ELMA_BPM.pdf
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Fig. 58. ELMA Designer. The " Procurement request" business process. Exporting. Step 1 

5. In the second step, you should select the Purchase request checkbox, 

a process analysis will be performed, and an information window will 

be displayed (

 

6. Fig. 59). ELMA always checks related objects and suggests including 

them in the exported package. 
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Fig. 59. ELMA Designer. The " Procurement request" business process. Exporting. Step 7 

Note that only the last published version of the process, object or 

document type is exported. In our example, we have changed only one 

of the process tasks, while the object “file” remains unchanged, so we 

will not to include this object in the export of the configuration. Note 

that in ELMA it is possible to export not only the objects created by 

users, but also object instances. 

  

7. Upload the exported file “Procurement request 26.07.2017.elma3” to 

the production server and run ELMA Designer. You can upload several 

ELMA configurations and run them on one computer. Read more about 

how to do this in 2.3 ELMA BPM Platform User Manual. 

 

8. Then go to Menu - Configuration – Import Configuration, specify the 

folder and the name of the exported file (Fig. 60). 

https://www.elma-bpm.com/data/User_Manual_ELMA_BPM.pdf


Chapter 6  Configuring ELMA test server  

 

 

ELMA BPM Platform: Administrator Manual                               

77 

 

 

Fig. 60. ELMA Designer. The " Procurement request" business process. Importing. Step 1 

In the next step, ELMA checks the configuration file and opens the information window (Fig. 61. 

ELMA Designer. The " Procurement request" business process. Importing. Step 2 

9. ), click the Continue Import button.  

 

 

Fig. 61. ELMA Designer. The " Procurement request" business process. Importing. Step 2 
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10. Once the import is completed, you will be prompted to restart ELMA 

Designer (you do not need to stop or restart the ELMA web server in 

this case). You will need to restart the server if you add or modify 

system object (database structure). After restarting ELMA Designer, go 

to the Processes tab and publish the current draft of the Procurement 

process. Read more about process publication in the Section 5.1.11 

ELMA BPM Platform User Manual. 

 

11. Once the business process is published, all new process instances 

will be executed in accordance with the new policies. By default, these 

changes will not apply to the process instances started before the 

publication.  

 

  

https://www.elma-bpm.com/data/User_Manual_ELMA_BPM.pdf
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Chapter 7. System Update 
We constantly evolve and develop ELMA BPM, in new versions we add new 

sections, components and features or improve the existent ones. We also 

continuously improve system performance. Each new version is tested before 

being released. Along with the version release, we publish critical changes in the 

Knowledge Base under Critical Change Lists. In the example below, we explain 

what each digit stands for in the version number (Fig. 62). 

 

Fig. 62. ELMA version number 

Major version number – Increases only when important changes are made 

to the system. 

Minor version number – The number of the release with small changes, bug 

fixes. 

Build number (further "build" or "revision") – The serial number of the system 

build as part of the version number. Generally, a version of ELMA has one build 

number available for download.  

You can download ELMA installation files form the member area at 

http://www.elma-bpm.com /. When selecting the system version for update, it’s 

necessary to consider two rules: 

1. You can update a minor system version to a higher version, for 

example, from version 3.7.4 to version 3.7.8. 

2. Select the latest minor version, if you want to update to a major system 

version, for example, update from version 3.7.4 to version 3.8.9 

(provided that version 3.8.9 is the latest version available for 

download). 

Read more system update in the respective Knowledge base article. Update can 

take considerable time; during the update, the system will be unavailable for 

users. 

https://kb.elma-bpm.com/article-1823.html
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If you use the test server to configure the system, it is recommended first to 

update the test server, check the overall functionality of the system and the 

performance of the business processes, and only then update the production 

sever. All triggers, indexes, foreign keys and stored procedures added by the 

system administrator, will be deleted during the update. It will be necessary to 

create them again by running a previously generated SQL script in the database 

manager. 

Before the system update, you should: 

 Stop the web server; 

 Create a backup copy of the database; 

 Create a backup copy of the configuration folder. 

The first launch of ELMA after the update may take longer than usual. This is 

due to the database processing (changing the structure), creation of the 

database backup. 

You may also need to update some of the system components or install new 

ones. There are two update options: manual update and package update. Manual 

update is carried out by transferring the necessary files to the system directory. 

Package update allows you to automate the update process. Use the manual 

update option, if the package update cannot be performed via the web interface. 
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7.1 Package update of the system 

Packages allow installing, updating and deleting components and modules of 

ELMA by using packages, i.e. files of a certain format that contain the module 

description, the compiled code of the module, and also the module source code, 

if necessary. 

 Package update procedure: 

1. Place the packages with the nupkg extension in the Packages subfolder 

which is stored in the ELMA folder.  

2. Restart the ELMA web-server.  

3. Go to the page Administration – System– Components. 

4. Click the upper menu button Install Components (Fig. 63). 

 

Fig. 63 Page "Administration – System– Components". The "Install Components" button. 

5. Then select components that you need to install/update (Fig. 64).  

 

Fig. 64 Select components for installation  

6. In the dialog box that opens (Fig. 65), you will see a warning about 

the server restart. Click Yes to continue the installation. During the 

installation of the components, the server will not be available. 
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Fig. 65 Warning about server unavailability 

7. Once the server is restarted, the component becomes available for 

users.  
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7.2 Manual update (transferring system modules) 

If the package update was not performed correctly and the modules were not 

installed/updated, you can update the system manually. 

Warning! Manual update carries some risks. You must create copies of the 

deleted files before updating the system. 

The module consists of two files with the .nupkg extension. For examples, the 

files EleWise.ELMA.Factory.Web.1.0.0.12.nupkg and 

EleWise.ELMA.Factory.1.0.0.12.nupkg. To install the module manually it’s 

necessary: 

1. Stop the ELMA web-server. 

2. By using the archiver, open the file 

EleWise.ELMA.Factory.Web.1.0.0.12.nupkg. Open the folder 

EleWise.ELMA.Factory.Web.1.0.0.12.nupkg\ELMA\WebModule\ and 

copy the folder EleWise.ELMA.Factory.Web to the folder..\<Shared 

folder with ELMA files>\Web\Modules. 

3. By using the archiver, open the file 

EleWise.ELMA.Factory.1.0.0.12.nupkg. Open the folder 

EleWise.ELMA.Factory.1.0.0.12.nupkg\lib\net40\ and copy the file 

EleWise.ELMA.Factory.dll to the folder ..\<Shared folder with ELMA 

files>\Web\bin and ..\<Shared folder with ELMA files >\Designer. 

4. Start the ELMA web-server. 

If the module has not been installed (updated), then delete all files in the 

folder..\<Shared folder with ELMA files>\Web\App_Data\ Dependencies. You 

must delete files when the web server is stopped. 
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Chapter 8. System settings   
To configure installed system modules, go to the Administration > System> 

System Settings (Fig. 66). 

 

Fig. 66 Administration > System > System Settings 

In this section, you can configure parameters of the system modules: messages, 

tasks, calendar, CRM, etc. Parameters of the modules are grouped in blocks with 

blue headings. The set of blocks depends on the set of the installed ELMA 

modules. Below are examples of the most common system settings. 

8.1 Outgoing mail settings 

In the Outgoing mail settings section, you can configure settings for outgoing 

messages to the system users via e-mail. Here you can configure the outgoing 

mail server (SMTP), the encoding of the messages, the sender's mailbox, and 

some settings for the email template. For a detailed description, see ELMA help.  

https://kb.elma-bpm.com/help/EN/Platform/content/Admin_SystemConfig_Mail_index.html
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Please note that IMAP access to a custom mailbox must be enabled on the mail 

server. You can learn how to check the settings, by contacting technical support 

of the mail server.   
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8.2 Configuring SMS notifications 

In the SMS Notifications Settings, you can configure connection settings with 

SMS service provider. 

This service allow you to integrate ELMA with the short messages service. If a 

user has specified their phone number in the user profile, they will receive an 

SMS alert each time they are assigned a high propriety task. It is required to 

register on the website of the SMS provider and pay for an sms package. Once 

it is done, proceed to the module settings. 

  

https://kb.elma-bpm.com/help/EN/Platform/content/Admin_SystemConfig_SMS_index.html?ms=AwgAAAAAAAAAAAAAAAAQIEA%3D&st=MA%3D%3D&sct=MjAw&mw=NDQ5
https://kb.elma-bpm.com/help/EN/Platform/content/Admin_SystemConfig_SMS_index.html?ms=AwgAAAAAAAAAAAAAAAAQIEA%3D&st=MA%3D%3D&sct=MjAw&mw=NDQ5
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8.3 Configuring integration with LDAP 

ELMA allows integrating with the directory service using the LDAP protocol. With 

LDAP, you can import users to ELMA. Please note that users synchronized via 

LDAP authorize through the directory service server, so even the ELMA 

administrator is not able to change the password. Once the module is configured, 

users are imported manually. 

You can read more about integration with LDAP settings in ELMA help, learn 

more about user import here. 

 

 

  

https://kb.elma-bpm.com/help/EN/Platform/content/Admin_SystemConfig_LDAP_index.html?ms=AwgAAAAAAAAAAAAAAAAQIEA%3D&st=MA%3D%3D&sct=MjAw&mw=NDQ5
https://kb.elma-bpm.com/help/EN/Platform/content/Admin_Users_LDAP_index.html?ms=BxgAAAAAAAAAAAAAAAAwIAJACA%3D%3D&st=MA%3D%3D&sct=MzAw&mw=NDQ5
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Chapter 9. System Diagnostics 
It is important to carry out system diagnostics to detect poor performance or 

system malfunction. There are both internal tools for diagnosing the system, and 

third-party tools (Firebird, SQL, etc.). 

9.1 Standard system diagnostics  

By default, this option is disabled. When system diagnostics is enabled, it will 

record information about events, errors and performance of ELMA. Recording 

information slightly reduces system performance. That is why you should select 

this option only when needed. The diagnostics almost does not affect page-

loading speed. To enable this options go to Administration > System > System 

Diagnostics. This section allows you to configure: 

1. Generate reports automatically – the following settings are available:  

 Report Generation Period – Specify the time when the system starts 

collecting statistics, as well as select the interval at which the new 

reports will be generated; 

 Statistics Reset Period – If this parameter is not set, the system shows 

statistics for the entire diagnostics period.  

2. Log enabled/disabled – A file, which contains detailed information about 

ELMA performance. The log detalization level is determined in the system 

diagnostics settings. Please note that the enabled log can significantly 

reduce system performance, and as a result, it is recommended to use this 

diagnostic tool carefully. 

3. Use performance counters – Enables built-in Windows performance 

counters. You can use three performance counters: 

 Average runtime of background tasks; 

 Average time for executing Web queries; 

 The number of SQL queries for the time interval. 

For quick system diagnostics, you need set up Report generation period to 

“Every hour”, Statistics Reset Period to “After every report export” (see Fig.67).  

Analyze the obtained statistics, by comparing reports with each other and with 

the user reports about slow system performance.  
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Fig.67. Configuring system diagnostics  

Detailed information about the module configuration is available in the ELMA 

help. 

9.1.1. Performance report 

A system performance report can be generated automatically. Enable this option 

by selecting “Generate reports automatically” and configure it in accordance with 

the Help article. In this section, we describe how to analyze information 

contained in reports. 

You can download the latest report, generated at the current period of time, in 

the Administration > System > System Diagnostics > Reports (Fig. 68), earlier 

versions of the reports can be found in the folder..\<Shared folder with ELMA 

files> Web\logs\Diagnostics \ Reports. 

https://kb.elma-bpm.com/help/EN/Platform/content/Admin_Diagnostics_index.html?ms=BxgAAAAAAAAAAAAAAAAwIAJACA%3D%3D&st=MA%3D%3D&sct=NTk1&mw=NDQ5
https://kb.elma-bpm.com/help/EN/Platform/content/Admin_Diagnostics_index.html?ms=BxgAAAAAAAAAAAAAAAAwIAJACA%3D%3D&st=MA%3D%3D&sct=NTk1&mw=NDQ5
https://kb.elma-bpm.com/help/EN/Platform/content/Admin_Diagnostics_index.html?ms=BxgAAAAAAAAAAAAAAAAwIAJACA%3D%3D&st=MA%3D%3D&sct=NTk1&mw=NDQ5
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Fig. 68 "Administration > System > System Diagnostics > Reports" 

The system performance report provides general information on system 

performance indicators, as well as more detailed information about web queries, 

scripts, background tasks, SQL queries, objects, and methods. In addition, this 

report shows summary information about the installed system (version number, 

build, system edition), and the DBMS. There are several tabs that show 

corresponding information. Below you will find the description of each tab.  

Please note that it is extremely uninformative to consider the reports separately. 

To obtain objective information it is necessary to conduct analysis of reports for 

different periods of time, comparing the obtained statistics.  

9.1.1.1. "Total" tab 

The Total tab (Fig.69) contains general information on the system's indicators. 

In the second line, you can see the statistics collection period. 
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Fig.69. Performance report. The "Total" tab. 

This tab is divided into two sections: 

 Web queries – User actions in the web browser when working with 

ELMA: task execution, document viewing, navigation through links, 

etc.; 

 Background task – The activity of the system that does not depend 

directly on the users actions in the web browser: tasks execution 

triggered by timer, alerts, etc. 

You should pay attention to the Time of SQL queries parameter.  
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Time of SQL queries is the time it takes to process SQL queries, compared to 

the entire time of processing other tasks, for example, web queries, background 

tasks, etc. 

The value of this parameter should not be too high; the normal value is about 

30%. If this percentage is too high (50% and higher), this means that the 

operation of DBMS takes too much time and possibly this causes low 

performance. If the percentage is small, but the system runs slow, then the 

possible cause may be insufficient resources of the application server (IIS, 

Cassini). 

9.1.1.2. "System Information" Tab 

The Information about the server tab (Fig.70) contains information and system 

characteristics.   

 

Fig.70 Information about the server. Checking the version of the server  

This tab will be useful if you use ELMA with MS SQL DBMS. It allows you to make 

sure that the MS SQL server and the Windows server have the same 

architecture. It is recommended to use the MS SQL server x64, which allows 

using a large amount of RAM. 

9.1.1.3. "Web queries" tab 

As mentioned above, the Web queries tab contains information about the queries 

generated by users via the web interface of the system. Fig.71 shows the tab 

with the highlighted fields, which you should pay attention to.  
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Fig.71. Performance report. Web queries tab 

Sort the data in the Average time per query column, in order to get information 

about the most slowly running system queries. Next, check the Queries column. 

Do not worry if the number of queries is small and the average query execution 

time is long. It is due to the first page load takes longer than subsequent page 

loads. We recommend taking into account queries that repeat 10 times or more. 

Once you have identified frequently repeated queries with slow load, check the 

URL column to determine what query it is. 

For example, consider these queries: 

/Workflow/WorkflowTask/Execute [POST] – Execute task 

/Workflow/WorkflowTask/Execute – Open task 

/Common/EntityHistory/History – Object history 

/SDK.Action/DynamicForms/ProcessPropertyValueChanged [POST] – Execution of dynamic forms 

/Documents/Document/View – Document view  

/Docflow/Route/Info [POST] – Get document routs 

/SDK.Action/Ping/Ping – Service ping to check activity (does not affect performance) 

/ContentArea/Page/Home – Home page 

/Processes/ProcessHeader/Start [POST] – Start process 
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/Processes/WorkflowInstance/Info – Process information 

/Tasks/Task/ – Work on tasks 

 

The most frequently detected slow queries are loading pages, loading modified 

display forms, loading portlets, getting multiple routes, long history, and actions. 

In such cases, to improve performance, it is recommended: 

 reduce the number of portlets on the page; 

 enable asynchronous loading of portlets; 

 do not place multiple lists on the page; 

 limit the number of items in the view (max 15). If it is necessary to 

display more items (50, 100), display them on a separate page; 

 when modifying display forms, do not overload them. 

We also recommend you to pay attention to the SQL columns: Total time of SQL 

queries and Time for SQL queries (in %). They show how much time is spent for 

the SQL query processing comparing to the total execution time. If the values 

are too large, you should refer to the SQL query tab for more information to 

identify the problem. 

9.1.1.4. "Scripts" tab 

The Scripts tab (Fig.72) shows all scripts that users create in the ELMA Designer. 

Script execution time depends on the quality of the script code and queries. 

Read the information in the Method column as follows: Process 

name_Scripts.Script name (Process name). 

 

Fig.72. Performance tab. The "Scripts" tab 

Above all, you should pay attention to the Total Time and Average Time columns. 

They show how much time it takes to execute a script. If the script execution 
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takes more than 20 seconds, provided that it works with the database, or 

changes the name of the document, or performs other similar simple operations, 

it is considered not optimal.  

When analyzing performance reports, take into account that requests to external 

systems are performed longer than usual. For example, consider the Count script 

in the Receiving faxes and Receiving incoming email processes. It’s average 

execution time is 4 seconds. Although the value is high, it is acceptable, because 

mail is received from an external server.  

9.1.1.5. "Background Tasks" tab 

The Background tasks tab (Fig.73) shows system tasks (for example, preview, 

start of processes according to schedule, execution queue, etc.), as well as tasks 

initiated by a user (for example, publishing a process, starting a process, etc.). 

 

Fig.73. Perfomance report. The "Background tasks" tab 

It is important to pay attention to user queries. Check the Average time per 

execution (milliseconds) column to get information about the queries. For 

example, if a process was started by timer, the value in the column must not be 

high. If the value is too high, check whether any script runs after the process 

start, it can affect the execution time. 
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9.1.1.6. "SQL queries" tab 

This tab (Fig.74) shows information about the time spent on the execution of 

the SQL queries. This information will be useful, if you think that SQL-queries 

negatively affect the system performance. In this case, values in the Time for 

SQL queries (in %) will be very high. We recommend analyzing the statistics for 

a few days, to make sure that the problem persists.  

 

Fig.74 Performance report. "SQL queries" tab 

When analyzing the information in this tab, do not take into consideration lines 

with small number of queries, the basic information on the execution time is 

shown in the columns Total time and Average time. The time for executing 

simple queries with one table is considered optimal if it does not exceed 3 

seconds. When executing complex queries that include many tables and 

columns, the time will be different, due to the large amount of processed 

information. An example of a complex query is a new report in the Report section 

or in Process monitor.  

If you have detected some problematic areas in the report, you should refer to 

the Query column, where the SQL query is specified, and understand its purpose 

to analyze and reproduce it.   

Caution! The "Query" column often contains duplicate queries, as a rule, their 

average execution time is approximately the same. In addition, we draw your 
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attention to the fact that the queries do not contain data called from the system, 

direct copying to the database is impossible. 

Consider how to read similar queries, using the MS SQL database as an example. 

Look at the query in the Fig.74. In the first line, you can see the query SELECT, 

which runs on average 9.5 seconds, in the first column you can read it: 

SQL query architecture 

SELECT count(this_.Id) as y0_ FROM TaskBase this_ WHERE this_.CreationAuthor = @p0 and 

(this_.NotShowInLists is null or this_.NotShowInLists = @p1) and this_.EndDate < @p2 and this_.Status 

in (@p3, @p4, @p5, @p6, @p7, @p8, @p9, @p10) 

In this example, it contains the following information: 

 TaskBase – A table for fetching data; 

 CreationAuthor, NotShowInLists, EndDate, Status – table columns; 

 @p0 – @p10 – Transmitted data. 

Also queries can contain the TOP operator with the value 5, 15, 30, 50, etc., 

which indicates that the query is called from the page using the Grid (space 

divided into rows and columns), within ELMA - filters and document registers, 

process monitor, some portlets, task list, etc. 

 

Fig.75. Performance report. "SQL queries" tab 

It is impossible to completely reproduce the query, because it does not contain 

exact execution parameters. Using the query architecture, we can reproduce a 

similar query with different data. To do this, we indicate real values instead of 

variables @p0 – @p10. To find out the values, open MS SQL management studio, 

select the database and execute the following query: 

 
select Id, CreationAuthor, NotShowInLists, EndDate, [Status] from TaskBase 
 



Chapter 9  System Diagnostics  

 

 

ELMA BPM Platform: Administrator Manual                               

98 

 

The output will be as follows (Fig.76): 

 

Fig.76. MS SQL. Query to DB 

Now let us analyze the most common values in the columns and transfer them 

to the query that we have copied from the Performance Report. 

Execute the query (Fig.77): 

SELECT count(this_.Id) as y0_ FROM TaskBase this_ WHERE this_.CreationAuthor = 102 and 
(this_.NotShowInLists is null or this_.NotShowInLists = 0) and this_.EndDate is NULL and this_.Status 
in ('DD048B73-4E08-404A-B62E-C55222845CC4', 'FD7993C6-99C7-4B23-83CC-0F576A63C144', 
'85707EFE-806C-4EC6-8CD6-4D5E4EDD8B19', '34387AFA-6B70-476F-9D34-748732059003') 
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Fig.77. MS SQL. Executed query 

As a result, 1128 items were found in 0 seconds, i.e. the problem was not 

confirmed. Note that we have repeated the query with sample data, and not 

exactly with the original data. Thus, by repeating the same query using possible 

values of the parameters @p0-@p10, we can compare them and get a complete 

picture.  

The main reason for insufficient query performance is a suboptimal query 

execution plan. Therefore, based on the results of the query, it is recommended 

that you refer to the execution plan and analyze the query for using indexes. 

You can find more information about it in the next chapters. 

When analyzing the SQL queries tab of the performance report, it is important 

to pay attention to long-running small queries (for example, fetching data from 

a table according to one parameter). As a rule, they indicate that the system 

indexes are incorrect. Often, large queries that fetch data across multiple tables 

and multiple columns are very difficult to optimize. Often low performance is 

associated with a large amount of data; you can solve this problem by optimizing 

the search engine, rather than restoring the indexes. It is also important to pay 

attention from which table the data is fetched. If this is a system table (for 

example, Users, TaskBase, etc.), and it is executed slower, compared to earlier 

periods, it is necessary to restore the indexes. If the data is fetched from a table 

created by a user (for example, the HomeInfo property in a new object "Real 

Estate Information" created in ELMA Designer), then most likely you need to 

create new indexes for it. 

9.1.2. Report about current system activity   

In this report, web queries and background tasks are highlighted in blue; the 

query execution stack (methods, SQL queries) is white. The first column displays 
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the date and time when the query or task was created, in the second column, 

the information in shown as follows (Fig.73):  

 

Fig.78. Current activity report 

If it is a task:  

#internal sequence number in ELMA [User Id] [IP address] [Where the query 

came from]/query URL. 

If it is a query: 

# internal sequence number in ELMA/ query URL. 

If a string does not contain URL, it means that this is a background task.  

This report will be useful in the following cases: 

 the system has stopped responding as a result of any user actions (for 

example, the document was sent for agreement to 1000 users); 

 the system has stopped responding as a result of the script execution; 

 to prevent hangs in case of a significant decrease in system 

performance. 

When the system stops responding, in the current activity report, at the very 

top, you will see the oldest query that slows down the system. You can also 

determine whether a query has hung by its creation time (for example, if the 

query was created 10 minutes ago from the current time, then you can say that 

it hung). Usually the current activity tab shows a small number of queries, which 

were created 0-3 minutes ago. If the system has become much slower to 

respond to user actions, then you will see a large number queued queries. 
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9.2 Process execution queue 

The Execution Queue sub-section allows you to monitor the processes that are 

currently processed by the Process Execution Service, and track execution 

errors. If a process has failed in performing an operation, error logs will be 

displayed in this section. To open the section, go to Processes > Execution Queue 

(Fig. 79). By default, this section is only available to users who are members of 

the Administrators group. 

 

Fig. 79. Diagnostics. Execution queue 

A detailed description of the Execution Queue is available in the section 5.3.4 of 

the ELMA BPM Platform user manual.  

  

https://www.elma-bpm.com/data/User_Manual_ELMA_BPM.pdf
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9.3 Error logs (information logging) 

Logging is the most important, and sometimes the only available tool for 

analyzing system failures and problems. Simply put, any log contains 

information about the date, time, and event. The name of the log files usually 

contains the name and date. By default, all logs are saved daily: one day - one 

log file. 

You can configure logging by setting up one of the following levels: 

 ALL – all massages; 

 DEBUG – debugging messages; 

 INFO – informative messages; 

 WARN – warnings; 

 ERROR – error messages; 

 FATAL – fatal error messages; 

 OFF – logging is disabled. 

If you select ALL, all system messages will be logged. If you change the level to 

INFO, the log will contain all messages except for debugging messages. Other 

levels work similarly. By setting up the level to OFF, you will disable logging. It 

is important to understand that high (detailed) levels of logging can cause a very 

significant slowdown of the system. In the section 9.3.1, you can find an example 

of changing a logging level. 

As a rule, system administrators use the default logging settings. 

9.3.1. ELMA BPM log 

All information about system events and errors are logged at ..\<Shared folder 

with ELMA files>\Web\logs. The following are the logs directly related to the 

system diagnostic: 

 dbUpdate – Database structure update log. A new log is added when 

the system version is updated or the object model changes; 

 Diagnostics – The diagnostic log. A new log is added according to the 

settings configured in the System Diagnostics section;  

 Diagnostics\Reports – System diagnostic reports that are generated 

when a user creates a report in the web application; 

 error – System error log; 

 ImportLog – Configuration import log; 
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 integration1C – 1C integration log; 

 workflow – Business process execution log. 

You can set up the logging level for the ELMA BPM Platform in the file ..\<Shared 

folder with ELMA files>\Web\Config\log4net.config. Using this file, you can also 

configure other settings; however, in most cases additional setup is not required. 

To switch to a higher level of logging, follow the example of setting up 

NHibernate full data display. You should make the following changes to the 

configuration file (only a part of the file is shown here): 

log4net.config, DEBUG level for NHibernate 

  <appender name="ErrorOnly" type="log4net.Appender.RollingFileAppender"> 

    <encoding value="utf-8" /> 

    <file value="logs/error/error-log-"/> 

    <appendToFile value="true"/> 

    <maxSizeRollBackups value="100"/> 

    <maximumFileSize value="100Mb"/> 

    <rollingStyle value="Composite"/> 

    <staticLogFileName value="false"/> 

    <datePattern value="yyyyMMdd"/> 

    <lockingModel type="log4net.Appender.FileAppender+MinimalLock"/> 

    <filter type="EleWise.ELMA.Logging.Log4netAndFilter, EleWise.ELMA.SDK"> 

      <filter type="log4net.Filter.LevelRangeFilter"> 

        <levelMin value="DEBUG"/> 

        <levelMax value="FATAL"/> 

      </filter> 

      <filter type="log4net.Filter.LoggerMatchFilter"> 

        <loggerToMatch value="NHibernate" /> 

        <acceptOnMatch value="false" /> 

      </filter> 

    </filter> 

    <layout type="EleWise.ELMA.Logging.PatternLayout"> 

      <conversionPattern value="%-5level %date [%thread] %logger – %message%newline"/> 

    </layout> 

  </appender> 

 

… 

 

  <logger name="NHibernate"> 

    <level value="DEBUG"/> 

  </logger> 

 

… 

 

  <root> 

    <level value="DEBUG"/> 

   <!--<appender-ref ref="All"/>--> 

    <!--<appender-ref ref="All-Location"/>--> 

    <appender-ref ref="ErrorOnly"/> 

    <!--<appender-ref ref="ErrorOnly-Location"/>--> 

  </root> 
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9.3.2. ELMA Designer Logs 

You can find ELMA Designer logs at ..\<Shared folder with ELMA 

files>\Designer\logs. The following are the logs most frequently used in 

diagnostics:  

 all – ELMA Designer events log; 

 error – ELMA Designer error log. 

You can set up ELMA Designer logging using the same syntax as shown in the 

previous paragraph. All settings are done in the configuration file..\<Shared 

folder with ELMA files>\Designer\Config\log4net.config. 

9.3.3. Web server logs 

When using the internal Cassini web server, the logs are located at..\<Shared 

folder with ELMA files>\Service\logs\. Below are the logs: 

 all – ELMA Designer events log; 

 error – ELMA Designer error log. 

To configure logging use the configuration file..\< Shared folder with ELMA files 

>\Service\LogSettings.xml. 

LogSettings.xml 

<?xml version="1.0" encoding="utf-8" ?> 

 

<LogSettings> 

  <logenabled value="true" level="ALL" query="0"/> 

</LogSettings> 

When using IIS as a web server, to configure logging, go to Start > Control Panel 

> Administrative Tools > Internet Information Services Manager. Next, go to 

the website and select Logging in the IIS group (Fig. 80). 
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Fig. 80. IIS. Configuring logging 

Note that the time of the web server logs is specified relatively to the zero time 

zone (UTC ± 00: 00). 
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9.4 Database diagnostic tools 

A transactions concept is an integral part of any client-server database. A 

transaction is an indivisible sequence of data manipulation operators (read, 

delete, insert, modify), which results in one of two possible outcomes: either the 

sequence is executed if all the operators are correct, or the entire transaction is 

canceled if at least one of the operators cannot be executed successfully. 

For example, in ELMA, a transaction refers to an operation of editing a page of 

a document, contractor, or other system objet. If a server fails to change at least 

one field edited in one operation, all the changes will not be applied. Execution 

of scripts is a transaction as well. In the case of an error, the entire script will 

not be executed; data cannot be changed partly before an error occurred. 

Committing changes (COMMIT operation) occurs after clicking the "Save" 

button, the transition buttons, execution of the script activity, etc. 

When a transaction is performed, the server blocks data. A block is a temporary 

restriction on the execution of certain data processing operations. If the server 

did not use blocks, several transactions would change the same data. Users most 

often do not need to take any actions to manage blocks, but nevertheless, 

sometimes a hung blocked transaction can slow down the entire system. In this 

chapter, we describe methods for identifying and solving such problems. 

One of the most important ways to achieve high performance of the database 

server is to use indexes. An index accelerates the query process by providing 

quick access to data rows in a table, similar to how a pointer in a book helps you 

quickly find the information you need. Indexes are created for the columns of 

tables and views. For example, if you create an index on a primary key and then 

search for a row with data using the primary key values, the database server 

will first find the index value, and then use the index to quickly find the entire 

row with the data.  

Without an index, a complete scan of all table rows would be performed, which 

could significantly decrease performance. When installed, ELMA automatically 

creates all necessary indexes on the standard fields. New indexes may be 

required in case of using large custom extensions, creating new objects, or 

removing previously created basic indexes. Users create new indexes manually. 

It is important to be able to timely recognize the situation and take the necessary 

actions. In this guide, we will consider the methods for analyzing queries 
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mentioned in the section 9.1.1.6 in order to determine whether they were 

indexed. 

9.4.1. MS SQL DBMS diagnostic tools  

Use MS SQL Management Studio to work with MS SQL DBMS. 

If the system hangs, you can use the standard Management Studio reports to 

retrieve data about the current ELMA transactions on the MS SQL server and see 

if there are any blocked transactions in the system.  

To do this, we use the All Blocking Transactions report. Select the database and 

in the context menu go to Reports - Standard report - All blocking transactions 

(Fig.81).  

 

Fig.81. MS SQL Мanager. Blocked Transactions Report  

A window opens with active blocking transaction (Fig.82). In the first line, you 

can see a blocking transaction; in the next lines are queries that await to be 

unlocked.  
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Fig.82. MS SQL. Blocking transactions report 

If it is impossible to restart the server and you need to restore the system 

performance, you can force the required transaction to close. To do this, execute 

the kill51 query in the database, where 51 is the session identifier. You can find 

the ID in the Session ID column of the report (Fig.82). 

Once the query is executed, the transaction will be aborted; the changes stored 

in this transaction will not be applied. 

Another tool for diagnosing MS SQL is the Activity Monitor. To open it, in Object 

Explorer, right click the MS SQL Server Instance and select Activity Monitory 

from the drop down list as shown in the figure below (Fig.81). 
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Fig.83. MS SQL. Starting Activity Monitor 

In the window that opens (Fig.84), in the Overview section you can check the 

current system load.  

 

Fig.84. MS SQL. Activity Monitor 

To view the execution plan and the indexes used, run the following SQL query 

(Fig. 85).  
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Fig. 85 MS SQL. Executed query 

Next, in the window that opens, go to the Execution Plan tab (Fig.86). If this tab 

is not available, right-click on the free space in the SQL query section and select 

the Enable actual execution plan option in the menu that appears. 

 

Fig.86 MS SQL. Execution Plan 

The plan shows in % how many resources are spent on different operations. In 

Fig.86, 93% of resources are spent on CLUSTERED INDEX SCAN. In addition to 

the section/operation CLUSTERED INDEX SCAN, TABLE SCAN and INDEX SCAN 

operations shows that simple scanning is performed. Scanning does not always 

indicate a non-optimal operation of the query, but only if the following conditions 

are met: 

• A table contains a large number of entries; 

• A query returns a small number of entries. 

Scanning always indicates that there is no suitable index for the optimal query 

execution. 

Also, this tab displays the Index Processor tips for adding missing indexes. Right-

click and select Information about missing indexes to learn more about the 

processor's tips. The emerged window will contain a SQL query for adding an 

index and its description (Fig.87).  
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Fig.87. MS SQL. Tips for adding missing indexes  

Please note that the processors tips are not always optimal and do not guarantee 

a performance increase, so it is very important not to create unnecessary 

indexes. 

9.4.2. Firebird DBMS diagnostic tools 

If the ELMA server is running on the Firebird DBMS, then it is possible to use the 

standard functionality of the IBExpert - Database Statistics and Database 

Monitoring to obtain statistical data. To do this, select the database, go to 

Service-Database Statistics and in the opened window click on the green triangle 

Retrieve Statistics (Fig. 88).  
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Fig. 88 IBExpert. Database statistics 

The generated statistics are divided into four tabs: 

• Text - contains summary information on the database in general and 

the used tables; 

• Tables - information on the tables used; 

• Indices - statistics on the indices used; 

• Option - standard settings (as a rule, do not need to be changed). 

If the system noticeably slows down, check whether you have an unclosed 

transaction somewhere in the database. You can see this by comparing values 

in the fields Oldest active transaction and Next transaction – the values should 

not differ significantly. The greater the difference between the oldest active and 

the next transaction, the greater the possibility of performance problems. 
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Another way to see the list of current transactions, including those blocked, is 

to use Database Monitoring. To do this, select the required database instance 

and open the Services - Database monitoring menu (Fig.89). 

 

Fig.89. IBExpert. Database monitoring 

The window (Fig.90) in the Transactions section contains a list of current 

transactions. To interrupt the transaction, select it and click the Rollback Tr.# 

Transaction number. 

 

Fig.90. IBExpert. DB Monitoring  

IBExpert displays the execution plan in the text form (Fig.84). To see the plan 

as a graphical summary (Fig.92), run the SELECT query to the database (see 

Section 6.1). The summary shows total number of executed queries, including 

the number of indexed and non-indexed queries, as well as updates, deletions 

and insertions. Then, after running the query, go to the Performance Analysis 

tab (Fig.92). 
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Fig.91. IBExpert. Execution Plan 

 

Fig.92. IBExpert. SELECT query statistics 

9.4.3. PostgreSQL DBMS diagnostic tools 

As a tool for diagnosing the database on the PstgreSQL server, you can use the 

utility pgAdmin III. Before using the utility, you have to enable logging. You can 

do this by setting up the appropriate parameters in the database configuration 

file postgresql.conf (the default path is ..\<Shared folder with ELMA 

files>\PostgreSQL\data\postgresql.conf). Open the configuration file for editing, 

find the logging_collector parameter and set it to on. In this file in the ERROR 

REPORTING AND LOGGING section, you can configure various additional 

parameters for storing and collecting information, priority, etc. Check this link 

to find more information about the said parameters. It is important to check the 

https://postgrespro.ru/docs/postgresql/9.5/runtime-config-logging
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configuration parameter lc_messages - it should specify the encoding 

Russian_Russia.UTF8, because the database uses it by default. If the value is 

different, errors can occur later when viewing log files with pgAdmin. 

Once logging is set up to display information about blocking and active processes 

in pgAdmin, go to the Tools - Server Status tab. The window shows a table with 

processes and a table with the existing database blocks (Fig. 93).  

 

Fig. 93 PostgreSQL. Blocking transaction report 

In the table, each blocking and blocked process is shown in a separate row. To 

determine which process is blocking other process, it is necessary to compare 

several rows and find rows with the same values in the Relation column and 

different values in the Allow column. To cancel the request or finish the selected 

process, click the respective buttons in the window. After completing any of the 

processes, you need to refresh the window and compare the rows to evaluate 

the result. 

To make search more convenient and eliminate blocks, you can run other 

utilities, for example, free pgSqlBlocks.   

To view the query execution plan in pgAdmin, open the SQL query editor, fill in 

your query and click on the Build execution plan button in the toolbar (Fig.94). 

http://pgcodekeeper.ru/pgsqlblocks.html
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Fig.94. PostgreSQL. Query execution plan 
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9.5 Recommendations for improving performance  

The following are recommendations to prevent problems that reduce the 

performance of ELMA: 

1. Use a server with sufficient capacity. You can find the recommended 

system requirements for each of the ELMA editions on our website. It is 

advisable to allocate more resources than it is recommended and, after 

determining the server load, remove unused resources. In the opposite case, 

you might face the problem of the slow server operation and solving this 

problem will always be one of the priority tasks. 

2. Keep track of the content, which is loaded on the user main pages. The 

loading time of the page can be significantly reduced. To do this, it is 

advisable: 

 Use asynchronous loading of portlets (see ELMA Help for configuring 

asynchronous loading); 

 Optimize performance of the Code portlets; 

 Reduce the number of displayed items in the list (for example, in 

dynamic tables); 

 If possible, limit the use of portlets, which are overloaded with data. 

3. If portlets perform long-term calculations and load large data volumes, but 

are not frequently used, it is advisable to place these portlets on the 

separate pages. In case if these portlets are used frequently, customize 

them to load data directly from the database. 

4. If several object instances are used simultaneously, use counters or 

timers, i.e. if possible, split a large script into a cycle of smaller operations 

(no more than 20 per cycle). Such operations include, for example, 

downloading and updating services objects, downloading one thousand 

documents at once, checking all active tasks in the system, sending alerts, 

etc. A map of such a process is given in Fig.95. 

https://www.elma-bpm.com/system-requirements-new/
https://kb.elma-bpm.com/help/EN/Platform/content/User_Portlet_settings_index.html?ms=EwAAAAAAAAAAAAAAAAAEAgQ%3D&st=MA%3D%3D&sct=MA%3D%3D&mw=MjQw
https://kb.elma-bpm.com/help/EN/Platform/content/User_Portlet_Cod_index.html?ms=EwAGAAAAAAAAAAAAAAAEAgQQAQ%3D%3D&st=MA%3D%3D&sct=MTAw&mw=NDUy
https://kb.elma-bpm.com/help/EN/Platform/content/User_Table_settings_index.html?ms=IwAAAAAAAAAAAAAAAAAEAhA%3D&st=MA%3D%3D&sct=MTAx&mw=NDUy
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Fig.95. An example of splitting a script into sevearl iterations. 

5. Simultaneous execution of several resource-intensive background tasks 

(loading of data from third-party resources, synchronization with other 

programs, analysis of indicators, calculations) can slow down the 

performance of the ELMA server. To prevent such problems, it is advisable 

to monitor the server load using the task scheduler (ELMA web application 

in the Administration > System > Scheduler), efficiently distribute tasks 

in time, and whenever possible, remove tasks with low priority  

6. Disable auto update of the process monitor cache; schedule it for 

nighttime. Configure these settings in the Administration > System > 

Process Monitor Settings. 

7. Monitor the load of the SQL server and web server and optimize it. 

8. Try not to use the FindAll () and similar methods  in scripts that return all 

objects of a certain type, which can create a significant load on the system. 

Instead, we recommend using filters to return a narrower number of 

objects. Read more about filters here. 

9. We do not recommended using the text field search. Much faster is to 

search by links to other objects, dates and numbers. For example, search 

a document with the attribute "Place of the conclusion of the contract" of 

the "Country" type by the object "Country", rather than use the name of 

the country with the type "Line" or "Text". 

https://kb.elma-bpm.com/help/EN/Platform/content/Admin_Tasks_plan_in_web_index.html?ms=IwQAAAACAAAAQAAEAAAcMkABQAIE&st=MA%3D%3D&sct=MTQ2NQ%3D%3D&mw=NDUy
https://kb.elma-bpm.com/article-1180.html
https://kb.elma-bpm.com/article-1180.html
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10. Use caching in frequently used objects, if the object data is rarely 

corrected. You can enable this setting in ELMA Designer on the Additional 

tab of the object (Fig. 96).  

 

Fig. 96 ELMA Designer. Object page. "Advanced" Tab 

Therefore, to evaluate the instantaneous load on the system, you should use the 

Current Activity Report in ELMA and the reports on blocking transactions in the 

database management environment. If you need a more detailed information on 

the system performance, please refer to the Report on system performance in 

ELMA, collected over a certain period of time. 
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Chapter 10. System recovery after a failure 
ELMA is quite resistant to failures. The stability of the system is higher; the less 

global changes are made to the system during its operation. However, it is still 

necessary to make changes to the system configuration (installing new modules, 

updating the system, working with direct requests to the database, scripts), 

which can result in ELMA failure. Therefore, it is important to make regular 

backups, to be able to restore the system. This chapter describes how to recover 

ELMA after various failures and explains the reasons of such failures. 

10.1 Typical errors when starting the ELMA server  

Below we describe common errors and methods for fixing them. 

Error:  Error initializing ELMA configuration ---> 

System.InvalidOperationException: Cannot check database exists ---> 

System.Data.SqlClient.SqlException: Failed to log in as user "IIS 

APPPOOL\Elma3-Standart". 

 Cause: Authorization on the IIS server is done under a user account that 

does not have administrator permissions. 

 Solution: If ELMA uses the IIS web server, to solve this problem go to IIS 

Manager (to open, click Start > Administrative tools). In the Application 

Pools tab, select ELMA3-Standart pool and in the drop-down menu select 

Advanced Settings. Then in the Process Model table, in the Identity field, 

specify the LocalSystem account or the actual account with the 

administrator permissions. Then restart the web server. Once the server 

is restarted, it is recommended to change the account name in the Identity 

field to ApplicationPoolIdentity (according to the section 4.2.2). 

 Alternative Cause: Using single sign-on to log in to the system and log the 

system in to the DBMS simultaneously. 

 Solution: Change the authorization type ELMA–DBMS to login-password 

authorization. To do this in the configuration file configuration.config in the 

string connectionstring add the field User ID and Password. See an 

example below: 
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Configuration.config 

<connectionStrings> 

        <add name="MainDB" connectionString="Data Source=TEST2; Initial Catalog=ELMA3; User 
ID=sa; Password=123qwe!@#; AttachDbFilename=C:\Program Files\Microsoft SQL 
Server\MSSQL12.MSSQLSERVER\MSSQL\DATA\ELMA3.mdf;"/> 

</connectionStrings> 

 

Error: The underlying connection was closed: An expected error occurred 

on a receive: Unable to read data from the transport connection: An existing 

connection was closed by the remote host.: An existing connection was closed 

by the remote host:. 

 

 Cause: ELMA Server is started with insufficient access permissions.  

 Solution: If the server uses the Cassini DB, press the Windows button + R 

and type services.msc. A service window will open. Find ELMA web server, 

right-click on it, select Properties, and select the Log-on tab. If the server 

uses IIS, press Windows + R and type inetmgr. The IIS manager window 

will open. In the Connections window find the Application Pools item and 

select it. A list of the current pool opens, which must contain an entry 

about the ELMA server. Also, you can right-click on the ELMA server and 

select Advanced Settings. In the Identity field, specify LocalSystem 

account or an actual account with administrator permissions. Then restart 

the server. Once the server is restarted, we recommend to change the 

Identity to ApplicationPoolIdentity (according to the Section 4.2.2). 

Error: *System.UnauthorizedAccessException: Access to the path 

"С:\ELMA3-Express\UserConfig\configuration.packges" is denied. 

 Solution: Delete the .packages file from the UserConfig folder. 

 

 Error: Error when creating the ELMA database backup. 

 Cause: Not enough storage space. 

 Solution: Clear space for a database backup. 
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 Error: EleWise.ELMA.Runtime.Db.DbStructureException: Error updating a 

database structure ---> System.Data.DataException: Failed to execute the 

query DROP INDEX UK_principal_name ON sysdiagrams ---> 

System.Data.SqlClient.SqlException: An explicit DROP INDEX is not allowed 

on index "sysdiagrams.UK_principal_name". It is used to force the UNIQUE 

KEY constraint. 

 Cause: SQL Server Management Studio must not have any tables in the 

System Tables section. 

Solution: Stop the ELMA server, open SQL Server Management Studio, 

find the required database and open the list of tables. The System Tables 

section must not contain any tables. If it does, delete them and then start 

the server.    

 

 Error: Error caused by active connections to the database 

 Cause: When you restore a database from backup copies on the server 

with a different time zone, the server may store the information about the 

active connections that will not allow you to use it.  

 Solution: Create a backup and execute a query to the database. The query 

text: Delete from DB_ACTIVECONNECTION. 

 

Error: EleWise.ELMA.Runtime.Db.DbStructureException: Error updating 

database structure ---> NHibernate.TransactionException: Commit failed with 

SQL exception ---> FirebirdSql.Data.FirebirdClient.FbException: unsuccessful 

metadata update object INDEX is in use ---> 

FirebirdSql.Data.Common.IscException: unsuccessful metadata update 

 Cause: Update error. 

Solution: Restore the database backup. The procedure for creating a 

backup is described in the section 5.1.  

Error: *EleWise.ELMA.Runtime.Exceptions.ConfigurationInitializeExceptio

n: Error initializing ELMA configuration ---> 

System.InvalidOperationException: Failed to connect to the database ---> 

FirebirdSql.Data.FirebirdClient.FbException: Unable to complete network 
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request to host "127.0.0.1". ---> FirebirdSql.Data.Common.IscException: 

Unable to complete network request to host "127.0.0.1". 

 Cause: Error in the configuration.config file, in the string <add 

name="MainDB" connectionString="data source=127.0.0.1;initial 

catalog={CONFIGDIR}\base.fdb;user 

id=sysdba;password=masterkey;character 

set=UNICODE_FSS;dialect=3;server type=0" />. 

 Solution: Make sure that in the line <add name="MainDB" 

connectionString="data source=127.0.0.1; initial 

catalog={CONFIGDIR}\base.fdb;user 

id=sysdba;password=masterkey;character 

set=UNICODE_FSS;dialect=3;server type=0" /> there are no typos and 

the character case is correct.  

Error: *EleWise.ELMA.Runtime.Exceptions.ConfigurationInitializeException: 

Error initializing ELMA configuration ---> System.InvalidOperationException: 

Faild to connect to the database ---> System.Data.SqlClient.SqlException: 

Cannot open the ELMA database requested by the login. Sign-in failed. User 

Login Error "NT AUTHORITY\system". 

 Cause: The authorization on the Cassini server is carried out under the 

user account that does not have Administrator permissions.  

 Solution: You must start the ELMA server under the account that has the 

permissions of the Windows Administrator. To do this, go to Control Panel 

> Administrative Tools > Services, find the ELMA web server, right-click 

on it and select Properties. In the window that opens, go to the Log On 

tab, select This account and specify the account information.  

Error: An error of the MS SQL 2008 server and higher Login failed for user 

’NT AUTHORITY\system. Cause:The explicitly specified "ELMA" database could 

not be opened. [CLIENT: <local machine>]. Error: 18456, Severity: 14, 

status: 38. 

 Cause: Authorization is correct, the server is started with Administrator 

permissions, but the database is not available (or there is no permission). 

 Solution: In the SQL server, add the sysadmin role to the NT 

AUTHORITY\system group. To do this, in the Microsoft SQL Server 

Management Studio, open Security - Login Names and select the NT 
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AUTHORITY\system group properties. In the Server Roles menu, select 

the checkbox next to the sysadmin role. 

 

 

Error: *EleWise.ELMA.Runtime.Exceptions.ConfigurationInitializeExceptio

n: Error initializing ELMA configuration ---> 

System.InvalidOperationException: Failed to connect to the database ---> 

System.Data.SqlClient.SqlException: CREATE DATABASE permission is 

prohibited in the "master" database. Failed to add the "F:\ELMA3-

Standart\UserConfig\ELMA3.mdf" file as a database "ELMA3". 

o Cause: Error in the configuration.config file in the string 

AttachDbFilename={CONFIGDIR}\ELMA3.mdf; 

o Solution: Delete the string 

"AttachDbFilename={CONFIGDIR}\ELMA3.mdf" in the configuration 

configuration.config file. Once the changes are made, save the file and 

restart the web server.  
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Chapter 11. Submitting a request to Support  
The support website is a specialized website located at http://support.elma-

bpm.com. On this website, the representative of the Customer responsible for 

administration of the system (hereinafter referred to as the User) can 

communicate with the employees of the Contractor's company, post requests, 

and track the statuses of their requests. The website also provides access to the 

questions answers database, which contains information about system use 

cases. The Contractor grants access to the support website in the presence of a 

valid technical support agreement. 

Any contact with a support representative is considered as a request. There five 

types of requests: 

 Questions about system operation. Requests of this type require an 

explanation of the basic functionality of the system. 

 Bug reports. Users can report about issues in the system that caused 

to produce an incorrect or unexpected result, or to behave in 

unintended ways. Exceptions: 

o issues related to incorrect functioning of the equipment or 

operating system that affect the functioning of the system are 

not considered as bugs; 

o issues related to incorrect functioning of the system in case of 

non-compliance with technical requirements are not considered 

as bugs. 

 Improvement suggestions. Customer's suggestions to improve the 

system. 

 Consultation (additional service). System setup performed by the 

specialists of technical support on behalf of the Customer. Examples of 

consultations: writing scripts, configuring forms, processes, reports, 

etc.  

 System Extension (additional service). Extension of the basic 

functionality performed by an ELMA developer on behalf of the 

Customer (for example, new system module (modules). 

 

When writing a request to technical support, the following should be considered: 

 

http://support.elma-bpm.com/
http://support.elma-bpm.com/
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 the request text must clearly describe the order of user actions that 

led to an error; 

 it is important to provide screenshots. The screenshot should show the 

URL, date and time, user, current task (stage); 

 the request should include log files for the period from the date the 

process or document was launched (created) until the error occurred 

on the web server, ELMA server. 

 

If the problem is repeatable, then you should specify links to other 

requests, provide log files for the corresponding dates. 

  



Chapter 12    

 

 

ELMA BPM Platform: Administrator Manual                               

127 

 

Chapter 12.  Useful References 
Along with this user manual, the following sources describe the functions of ELMA 

applications: 

 ELMA BPM Platform user manual 

 ELMA Web Portal user manual 

 ELMA ECM+ user manual 

 ELMA Projects+ user manual 

 ELMA KPI user manual 

 ELMA High Load user manual 

These manuals walk you through the key features of the system. You can find a 

more detailed description of ELMA functions in the system Help, available via the 

following link: https://kb.elma-bpm.com/help and included in software package. 

ELMA HELP contains a wide range of articles that describe ELMA BPM Platform 

and its applications. All articles are grouped in three main sections: the User 

Guide, the Implementation Guide and the Administrator Guide Which allows you 

to quickly find the information you need. 

General description and purchase conditions of the applications are available on 

ELMA website: http://www.elma-bpm.com. You can also Ask a question on this 

website, using a respective link.  

An Online Demo http://demo.elma-bpm.com demonstrates the main functions and 

utilization of the applications. 

We continuously develop ELMA and create platform-based components for 

solving specific tasks. You can find the list of these components and their 

purchase conditions at ELMA Store: http://store.elma-bpm.com/.     

You may also find useful the articles in the ELMA Knowledge base if you develop 

your own system extensions. https://kb.elma-bpm.com/  

If you are experiencing technical difficulties, please visit ELMA technical support 

website: http://support.elma-bpm.com. 

If you need assistance with the system or have questions about partnership with 

the ELMA Company, contact us: 

Luxemburg:  + (352) 20-30-11-40 | http://www.elma-bpm.com/contacts/ 

https://www.elma-bpm.com/data/User_Manual_ELMA_BPM.pdf
https://www.elma-bpm.com/data/User_Manual_ELMA_Web_Portal.pdf
https://www.elma-bpm.com/data/User_Manual_ELMA_ECM.pdf
https://www.elma-bpm.com/data/User_Manual_ELMA_Project.pdf
https://www.elma-bpm.com/data/User_Manual_ELMA_KPI.pdf
https://www.elma-bpm.com/data/WP_ELMA_High_Load_book.pdf
https://kb.elma-bpm.com/help
https://www.elma-bpm.com/
http://demo.elma-bpm.com/
http://store.elma-bpm.com/
https://kb.elma-bpm.com/
http://support.elma-bpm.com/
https://www.elma-bpm.com/contacts/
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